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Chapter 1

Introduction

Videoconferencing (also known as Video Chat) takes place when two or more 

people communicate using video and some combination of audio, text, or graphics. 

CU-SeeMe is White Pine’s videoconferencing software for your desktop computer 

featuring color video, audio, chat, and data sharing. You can use CU-SeeMe on the 

Internet or any TCP/IP network for real-time person-to-person or group 

conferencing, broadcasts, and chats. Whether you are an instructor conducting a 

training class, a business manager communicating to a customer, or someone 

wanting to chat with a friend, you will be amazed at the ways CU-SeeMe will bring 

you closer!

In this chapter you will learn where to find information about CU-SeeMe and what 

you need to install your software. You will also get an explanation of CU-SeeMe 

conference types. This is helpful to understand before you begin your first 

videoconference.
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Where to Find Information
You are starting at the right place! With the help of this User Guide, you will be 

videoconferencing in minutes. This book guides you through the process of making 

your first connection, enabling you to see and speak with other people. This book also 

explains some of the most often used features of CU-SeeMe.

In addition to this book, there are other sources of information to help you use and 

enjoy CU-SeeMe:

Online Help 
CU-SeeMe comes with online Help, a complete reference tool that includes 

step-by-step procedures and additional information about CU-SeeMe that is not 

covered in this book.

(Windows)

Windows users can get Help in two ways:

◆ You can view the CU-SeeMe Help Contents window by choosing CU-SeeMe 
Help Topics from the Help menu. From the CU-SeeMe Help window you can 
select Help topics for more specific information.

◆ You can also get context-sensitive Help by clicking the Help button found in 
many dialog boxes and message windows or by pressing the F1 key.

(Mac OS)

Mac OS users can view CU-SeeMe Help topics by clicking the Help menu. Online 

Help is displayed in a Web browser window. You must have browser software, such 

as Netscape Navigator™ or Microsoft® Internet Explorer, to view the online Help.

WhitePineBoard Documentation Online (Windows)

The WhitePineBoard documentation (WPBoard.pdf) contains detailed instructions on 

using the WhitePineBoard. This is an Adobe Acrobat® file, available when you 

perform a Typical Install or select online manuals during a Custom Install. 

WhitePineBoard is available only to Windows users.
1-2     CU-SeeMe User Guide
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Web Pages
See the CU-SeeMe World Wide Web pages (http://www.cuseeme.com) for more 

information about CU-SeeMe, including product updates and technical support.

Other Books
For information on Microsoft® Windows®, consult the Windows user guide provided 

with your version of Windows from Microsoft, Inc. 

For information on Mac OS®, consult the user guide provided with your version of 

Mac OS from Apple® Computer, Inc.

Because CU-SeeMe has become so popular around the world, many books have been 

written about it. Here are a few:

Enhanced CU-SeeMe by Robert Rustici is published by MIS:Press, ISBN 

1-55828-490-7. This book explains the nuts and bolts and etiquette of 

videoconferencing with CU-SeeMe.

The Internet TV with CU-SeeMe by Michael Sattler is published by SAMS/

Macmillian, ISBN 1-57521-006-1. This book provides an 

in-depth look at the freeware version of CU-SeeMe.

Videoconferencing: The Whole Picture by Toby Trowt-Bayard is published by 

Flatiron Press, ISBN 0-936648-48-1. This book, a videoconferencing systems and 

network buyers guide, thoroughly describes all aspects of videoconferencing.

Windows® and Mac OS® Information
This User Guide provides CU-SeeMe instructions for the Windows® and Mac OS® 

operating systems. In most cases, CU-SeeMe works identically on Windows and Mac 

OS. When there are substantial differences, instructions for both operating systems are 

given. If information is not identified as being specific to one operating system or the 

other, it is appropriate for both. 
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System Requirements
There are many ways to use CU-SeeMe, depending on the hardware and software you 

have. If you want to send video from your computer, you need to have a video camera 

and a video capture card (sometimes referred to as a video digitizer card or an AV 

card), or use a digital camera that does not require a capture card, such as the 

Connectix QuickCam. You can receive video from other users even if you don’t have 

a video camera or a video capture card, however other users will not be able to see you.

On a computer running Windows, you need to make sure you have a sound card 

installed in your computer in order to send and receive audio. All Macintosh 

computers have sound capabilities built in.

White Pine maintains a list of recommended video capture cards, sound cards, and 

cameras that work with CU-SeeMe. This list is published online in our Frequently 

Asked Questions (commonly referred to as FAQs) on the World Wide Web at 

http://support.wpine.com/cuseeme.

Minimum System Requirements
To use CU-SeeMe, you need the minimum requirements listed in the following 

sections.

Windows

Computer Requirements:

◆ Windows 95/98 or Windows NT Version 4.0

◆ Pentium processor, 100 megahertz (MHz) minimum

◆ 16 megabytes (MB) of RAM (24 MB or more recommended)

◆ 10 MB of hard disk space

Network Connections:

◆ TCP/IP (Winsock-compliant), PPP for dial-up connection

◆ 28.8 Kbps (minimum) modem, LAN, Cable or ISDN connection

◆ IP address
1-4     CU-SeeMe User Guide
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To Send Video:

◆ Digital camera (such as the CU-SeeMe Cam, Connectix QuickCam, 3Com 
Bigpicture, and others)

- or - 

◆ Desktop video camera and video capture card

To Send Audio:

◆ Microphone

◆ 16-bit (minimum) sound card and drivers

To Receive Audio:

◆ Speakers or headphones

◆ 16-bit (minimum) sound card and drivers

Mac OS

Computer Requirements:

◆ Mac OS System 7.6 or later

◆ PowerPC processor, 100 megahertz (MHz) minimum

◆ 24 megabytes (MB) of RAM (32 MB or more recommended)

◆ 10 MB of hard disk space

Network Connections:

◆ Open Transport Version 1.1.2 or later

◆ 28.8 Kbps (minimum) modem, LAN, Cable or ISDN connection

◆ IP address

◆ PPP for dial-up connection
Chapter 1. Introduction          1-5
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To Send Video:

◆ Digital camera (such as Connectix QuickCam)

- or - 

◆ Desktop video camera and video capture card (such as Apple AV board)

To Send Audio:

◆ Microphone

To Receive Audio:

◆ Use built-in speaker, or optional external speakers or headphones
1-6     CU-SeeMe User Guide
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Installing CU-SeeMe
CU-SeeMe is easy to install and run on your computer. Follow the steps below to load 

the software onto your computer:

Windows

1. Insert the CU-SeemMe CD into your computer’s CD-ROM drive. Windows will 
automatically start the CU-SeeMe setup program.

2. Click on “Install CU-SeeMe” to proceed with the setup.

3. Follow the on-screen instructions to complete the CU-SeeMe installation.

4. To install the optional WhitePineBoard software, click on “Install 
WhitePineBoard” and follow the on-screen instructions.

5. Click on “Exit” to exit the setup program.

Mac OS

1. Insert the CU-SeeMe CD into your computer’s CD-ROM drive.

2. Double-click on the “CU-SeeMe Installer” icon.

3. Follow the on-screen instructions to complete the CU-SeeMe installation.
Chapter 1. Introduction          1-7



  

C
U

-S
ee

M
e 

A
ss

is
ta

nt
s

  
CU-SeeMe Assistants
CU-SeeMe includes many Assistants to help you accomplish tasks while using the 

program. Assistants are step-by-step guides that lead you through a process, such as 

creating a Contact Card, creating a Personal Profile and more.

When you have finished installing CU-SeeMe and you run CU-SeeMe for the first 

time, the CU-SeeMe Setup Assistant appears. Follow the steps as it guides you through 

the process of configuring CU-SeeMe for your first videoconference connection. 

Using this Assistant, you will set up your video and audio sources, create 

communication settings based on your network connection, and choose whether to 

share information to make it easier for other people to contact you using CU-SeeMe. 

See “Using the Setup Assistant” on page 2-2 for more information.
1-8     CU-SeeMe User Guide
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CU-SeeMe Conference Types
When you communicate with someone using CU-SeeMe, your conversation is called 

a conference. A conference can include communication using video, audio, text, and 

graphics. CU-SeeMe allows you to communicate with people using several conference 

types: 

◆ Point-to-Point Conference

◆ Group Conference

◆ Cybercast Conference

◆ Multicast Conference (Windows only)

The following sections will explain the first three conference types, since these are the 

most widely-used conferences. To learn more about multicast conferences, see 

“Multicast Conferences (Windows only)” on page 3-44.

Point-to-Point Conference
A point-to-point conference occurs when one person conferences directly with another 

person. Each person must have a computer running CU-SeeMe. You can be connected 

through the Internet or through a private network such as a local area network (LAN) 

or wide area network (WAN). A point-to-point conference is illustrated in Figure 1-1.

Figure 1-1. A point-to-point conference connects two people
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As an example, suppose you want to videoconference directly with a friend. You would 

need to know that friend’s Internet Protocol (IP) address. You can then use CU-SeeMe 

to call that IP address and conference with your friend, much like you would dial your 

friend’s telephone number if you wanted to connect for a telephone call. Like a 

telephone number, an IP address is a unique numeric identifier except instead of 

identifying your telephone, it identifies your network-connected computer. (If you use 

an online directory service, you can eliminate the need to know an IP address to make 

a call. See “Registering With an Online Directory Service” on page 5-24 for more 

information.)

Group Conference
A group conference provides a collaborative environment where co-workers, students, 

or whole families can participate in a conference. The most common way to participate 

in a group conference is to connect to a computer running conference server software, 

such as MeetingPoint Conference Server or the White Pine Reflector. Any video, 

audio, text, or graphics that you transmit is received by the conference server, then 

transmitted to all others connected to the conference. A group conference is illustrated 

in Figure 1-2. 

Figure 1-2. A conference server connects a group of people in a collaborative environment

A group conference has an IP address or host name that you use to call it, just like a 

point-to-point conference. Some group conferences require a unique conference ID 

number or password to join the conference.
1-10     CU-SeeMe User Guide
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Cybercast Conference
A cybercast (or one-way conference) is similar to television broadcasting. One 

computer, running conference server software, transmits audio and video to all users 

who connect to it. The individual users can not send video, audio, text, or graphics; 

they can only receive broadcast data. A cybercast conference is illustrated in Figure 

1-3.

Figure 1-3. A cybercast conference is like a TV broadcast for your computer

Some examples of cybercast conferences are NASA-TV broadcasts of video and audio 

during space shuttle missions, teachers who cybercast their lessons to remote students, 

and trade shows that broadcast video and audio of keynote speakers.
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Chapter 2

Making Your First 
Connection

Now that you have installed the CU-SeeMe software and checked to make sure your 

computer has the minimum system requirements (see page 1-4), you are ready to 

connect to your first videoconference. This chapter will guide you step-by-step into 

a videoconference where you will see and send video, talk with other people online, 

and exchange Chat text. Once you have taken the “Quick Start” approach presented 

in this chapter and you have participated in your first videoconference, you will want 

to try using additional features of CU-SeeMe. In subsequent chapters, you will 

discover all the fun and useful ways you can enhance your videoconference 

experience.

Remember, if you need more help, it is available online. See page 1-2 for 

information on using online Help.
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Using the Setup Assistant
The first time you start CU-SeeMe, you will see the CU-SeeMe Setup Assistant. This 

helps you set up your computer and prepares you for your first videoconference. If 

you’re not sure how to answer some of the Assistant’s questions, click the Help button 

for advice. You can adjust your settings later if you need to.

When you installed CU-SeeMe, you were given the option of running CU-SeeMe 

immediately after installation. If you chose this option, then the Setup Wizard 

appeared automatically. If you did not choose this option, then you must start 

CU-SeeMe manually. 

Windows

To start CU-SeeMe from the Windows desktop, click Start, point to Programs, point 

to CU-SeeMe, then click CU-SeeMe.

Mac OS

To start CU-SeeMe, open the CU-SeeMe 3.1 folder and double-click on the 

CU-SeeMe icon.

When CU-SeeMe starts, the CU-SeeMe Setup Assistant appears, as shown in Figure 

2-1.

Figure 2-1. The CU-SeeMe Setup Assistant helps you prepare for your first videoconference
2-2     CU-SeeMe User Guide
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This Assistant guides you through five steps, after which you will be ready for your 

first connection. The first step will enable you to define the personal information that 

you want to share with other CU-SeeMe users. Click Next to proceed. The dialog box 

shown in Figure 2-2 appears.

Figure 2-2. Define information to share with other CU-SeeMe users

The information in this dialog box is optional. Any information you enter here will be 

available to other CU-SeeMe users in a conference. You can enter, change, or delete 

any of this information at a later time. See “Editing a Personal Profile” on page 3-28 

for more information. When you are done entering information, click Next.

Your CU-SeeMe Name
is the name that 
appears when you 
conference with 
others.

Enter your name,
address, and e-mail.
This information
is optional and can
be edited later.
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You are now on step two, as shown in Figure 2-3.

Figure 2-3. You are on step two

Click Next to proceed. The dialog box, shown in Figure 2-4, appears.

Figure 2-4. You can register with an online directory service

You can choose to register and list your name on a Web-based directory services 

server. This will allow other CU-SeeMe users to locate you and connect to you without 

having to know your computer’s IP address ahead of time. (To learn more about 

registering with a directory service, see “Registering With an Online Directory 

Service” on page 5-24.) When you are done, click Next.
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You are now on step three, as shown in Figure 2-5.

Figure 2-5. You are on step three

Click Next to proceed. The dialog box, shown in Figure 2-6, appears.

Figure 2-6. Choose your network type

Using the drop-down list, choose your network type. You must choose a network 

configuration type that best matches your network. For example, if you are using a 

modem, select the corresponding modem choice. 

Click the arrow to 
display a list of network
types. Choose the one
that best matches your
configuration.

Click here to modify
your maximum
transmit and receive 
rates.
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Click Customize to modify the maximum rates at which you can transmit and receive 

data. This step is optional. The default settings work best for most users. When you are 

done, click Next.

You are now on step four, as shown in Figure 2-7.

Figure 2-7. You are on step four

Click Next to proceed. The dialog box, shown in Figure 2-8, appears.

Figure 2-8. You can see the video that you will send to others

Click here to select
your video capture
device or to change
your capture settings.
The default settings 
work best for most
users.

Click here to take 
your picture and 
add it to your Contact
Card.
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If you have a camera, you can use this dialog box to test the video image that you will 

be sending to others. This dialog box also displays a Contact Card, which is like a 

business card or a card in a rotary file. It is a convenient way to present and store 

information about a person or place. To learn more about Contact Cards, see “Contact 

Cards” on page 3-12. To learn more about storing information about yourself to send 

to others, see “Creating a Personal Profile” on page 3-25.

Click Take a picture to add your picture to the Contact Card. This is optional. The 

resulting card is shown in Figure 2-9.

Figure 2-9. You can take your picture and add it to your Contact Card

When you are done, click Next.

This Contact Card 
includes your personal
picture.
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You are now on step five, as shown in Figure 2-10.

Figure 2-10. You are on step five

Click Next to proceed. The dialog box, shown in Figure 2-11, appears.

Figure 2-11. You can adjust your microphone and speaker

Use this dialog box to test your microphone and speaker and make audio adjustments.

When you are done, click Next.

Click here to test
your speaker volume

Click here to select
your audio playback
device

Click here to 
select your audio 
recording device

Your microphone
volume is shown 
here

Microphone 
volume control

Speaker volume
control

Your speaker volume
is shown here

Select this if you 
have a full duplex
sound card
(Windows)
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You have now completed the CU-SeeMe Setup Assistant, as shown in Figure 2-12.

Figure 2-12. You are now ready to run CU-SeeMe and get connected

Click the Finish button, then continue to the next section to make your first connection 

and begin videoconferencing.
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If you are connecting to the Internet using an Internet Service Provider (ISP), you must 

be dialed into your ISP prior to starting CU-SeeMe.

CU-SeeMe is already set up to connect you to a group conference called the White 

Pine Cafe. This is a virtual cafe where you will meet other people who happen to be 

connected to the White Pine Cafe at the same time. These are real live CU-SeeMe 

users, just like you! 

Are you ready? Let’s begin.

Connecting to the White Pine Cafe
If CU-SeeMe is not already running, you must start the program. 

Windows

To start CU-SeeMe from the Windows desktop, click Start, point to Programs, point 

to CU-SeeMe, then double-click on the CU-SeeMe icon.

Mac OS

To start CU-SeeMe, open the CU-SeeMe 3.1 folder and double-click on the 

CU-SeeMe icon.

The Quick Start & Tips window appears, as shown in Figure 2-13. If the Quick Start 

& Tips window does not appear when you start CU-SeeMe, go to the Phone Book 

Help menu (in Windows) or the Window menu (in Mac OS) and click Quick Start 
& Tips.

Figure 2-13. The Quick Start & Tips window helps you make your first connection

Click to connect
to a live 
videoconference
at White Pine Cafe

Click to open 
Phone Book window
Click to open the
Phone Book 

Click to find out who
is currently online
with CU-SeeMe

Click to test your 
video and audio
settings
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Click Visit White Pine. A dialog box will appear, indicating that your computer is 

establishing a connection to the White Pine Cafe. Once the connection is made, a new 

dialog box appears, as shown in Figure 2-14.

Figure 2-14. You can choose from a variety of conferences in the White Pine Cafe

This dialog box offers a choice of conferences and provides information about each of 

them. In Chapter 3 you’ll find out what the various numbers and letters mean, but for 

now click Join to join the default conference. The next dialog box tells you that you 

are connected and displays theWhite Pine Cafe’s Message of the Day, shown in Figure 

2-15.

Figure 2-15. Message of the Day from the White Pine Cafe
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The Message of the Day is sent by the people who manage the White Pine Cafe 

conference, introducing you to the rules of their conference. Read this message to learn 

about any special rules or conditions relating to this conference, and then click Go! A 

new window will appear, called the White Pine Cafe (see Figure 2-16). This is the 

Conference Room window where videoconferencing takes place. Think of it as a 

virtual meeting room where you see and talk to others, and share written messages and 

graphics. Whenever you connect to a person or place, you will work in a Conference 

Room window, similar to this.

Figure 2-16. The Conference Room window is where you see and talk to others

The Conference Room is divided into several sections, as shown in Figure 2-16. If you 

have a camera connected to your computer, you will see your video picture in one of 

the video windows. If other people are connected to the White Pine Cafe, you will see 

their names listed in the Participants List. You will also see video images of some of 

these people. For example, in Figure 2-16, Heidi, Bill, Tom, and Phil are other people 

who are in the cafe. Additional participants, such as Forrest, Guillaume, Katrina, and 

others are also in the cafe but their video images are not currently displayed on your 

screen. When you are connected to the White Pine Cafe, you will not see the same list 

of names as shown in Figure 2-16 because you are connected to a changing group of 

real people. The list of participants will be different each time you connect. The 

number of video images you see depends on the type of network connection you have, 

the number of participants in the conference, and the video layout selected. See 

“Changing the Layout of the Video Windows” on page 4-23 for more information.

Menus

Toolbar

Participants
List

Audio 
controls and
indicators

Video windows

Chat window

Status bar
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Your name appears in the Participants List as CU-SeeMe User (Local). CU-SeeMe 

User is the default name assigned by CU-SeeMe. You can choose a different user 

name by defining a new user profile. To learn how to do this, see “Creating a Personal 

Profile” on page 3-25. The word (Local) is added to your name to indicate that it is 

being sent from your computer. You are the local participant. Other people in the 

conference are remote participants. In Figure 2-16, Willy is the name of the local 

participant.
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Seeing Other People
When the Conference Room opened, video images of some of the people in the 

Participants List appeared. By default, CU-SeeMe fills up all available video window 

frames with video images. To change this, see“Closing All Video Windows” on page 

2-15. Continue reading to learn how to control which people appear on your screen.

There are two categories of participants: senders and lurkers. Senders are sending 

video images and you can choose to see their images. Lurkers are not sending video 

images. Perhaps they don’t have cameras, or maybe they are choosing not to be seen. 

Whatever the reason, you will not receive a video image from a lurker. However, if 

you are sending video, both senders and lurkers can receive your image. 

Look at the Participants List in Figure 2-17. This list contains both senders and lurkers.

Figure 2-17. Participants List with senders and lurkers

To learn more about the Participants List and the information it presents, see 

“Participants List” on page 4-12.

Swapping Video Images
If you want to see a sender who is not currently displayed on your screen, you can click 

on a participant’s name to select it, and then drag it to a video window frame. This is 

called drag-and-drop. The new participant’s image will replace the previous image in 

that video window frame.

Senders have 
cameras

Lurkers do not 
have cameras
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Closing All Video Windows
If you don’t want all the video windows filled with images, or if you want more control 

over who you see on your screen, you can close all the video windows and then select 

only those participants you want to view. Note that this does not disconnect you from 

the conference; it only closes the video windows. You are still connected and others 

can still see you.

To close all video windows:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images.

2. Point to Close All, then click.

3. All the video images disappear.

Showing All Video Windows
To fill up all the video window frames again, follow these steps. 

To show all video windows:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images.

2. Point to Show All, then click.

3. All the video window frames will fill up with available video images.

To select individual video images, read the following section, “Seeing a Participant”.
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Seeing a Participant
You can choose which video images you want to see displayed on your screen. 

To see a participant:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images.

2. Point to the name of the participant you want to select, then click.

3. The video image is now displayed in one of the open video window frames.

4. You can repeat this process to see video images from other participants.

You can continue this until all the video window frames are full, or you can stop at any 

time. You do not need to fill all the video windows. In fact, having fewer open video 

windows will increase the performance of your computer during the videoconference.

Remember that the number of video images you can display depends on the type of 

network connection you have.To learn more about displaying video windows, see 

“Video Windows” on page 4-19.

Being Seen
Just as you can choose to see other people in the Participants List, other participants 

can also choose to see you if you are sending video. Whenever you join a conference 

or connect with someone, your video image will be displayed in the local video 

window. (If it isn’t, make sure your camera is properly connected to your computer 

and that it is turned on. Refer to the camera manufacturer’s instructions on installing 

your camera, if necessary.) If you have a camera connected to your computer, you are 

a sender. However, you can choose to become a lurker, which prevents others from 

seeing your video picture.

To switch between being a sender and a lurker:

(Windows)

1. Click the Video button on the toolbar

2. Click Send Video to switch. A checkmark indicates that you are sending video; if 
there is not a checkmark next to Send Video, you are a lurker

3. Click Send Video again to become a lurker. The ✔ disappears. You have stopped 
sending your video image to other participants
2-16     CU-SeeMe User Guide



Seeing O
ther People
(Mac OS)

1. Make sure that your local video image is displayed in one of the video window 
frames. If it is not currently displayed, see “To see a participant:” on page 2-16 to 
learn how to display your video window.

2. Hold down the CONTROL key as you click on your video window (CTRL-click). 
A menu appears. If you see a •  next to Send Video, then you are a sender.

3. Click Send Video to become a lurker. The •  disappears. You have stopped 
sending your video image to other participants

4. If you click Send Video again, you become a sender. You have now turned your 
video on and other participants can choose to see your video picture.

Note that if you do not have a camera attached to your computer, you are always a 

lurker. Some group conferences limit the number of lurkers that can be connected at 

any given time. If that number has been reached and you switch from being a sender 

to being a lurker, then you may be disconnected from that conference. If this happens, 

call the conference again.
Chapter 2. Making Your First Connection          2-17



C
ha

tti
ng

 w
ith

 O
th

er
s

Chatting with Others
Now that you are seeing some of the other people in the Conference Room, you may 

wish to exchange messages with them. One way to do this is to send typed messages 

to other people using Chat. Chat enables you to communicate, even if you don’t have 

a microphone or if your network connection is too limited to carry audio. 

Chat Window
Chat messages appear in the Chat window, as shown in Figure 2-18.

Figure 2-18. The Chat window allows you to exchange typed messages

To use the Chat window:

1. Type a message in the lower pane of the Chat window.

2. Press ENTER.

3. Your message now appears in the upper pane of the Chat window.

Other participants will see your message and you will see the messages that others are 

typing. You can follow Chat conversations in the upper pane of the window. Messages 

appear in the order in which they are received. 

To learn more, see “Chat Window” on page 4-26.

Type your 
message here
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Sending and Receiving Audio
In addition to seeing others, and exchanging Chat messages, you can also talk to other 

participants and hear their voices. To hear other participants, you must have speakers 

or headphones connected to your computer. To talk to other participants, you must 

have a microphone connected to your computer.

To learn about the audio features of CU-SeeMe, see “Audio Modes” on page 4-34 and 

“Audio Controls and Indicators” on page 4-36.
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Disconnecting From the Conference
When you are ready to leave the White Pine Cafe, you can disconnect from the 

conference in one of 2 ways.

To disconnect from a conference:

On the Conference menu, click Hang Up.

-or-

Click the Hang Up button on the toolbar.

This will disconnect you from the White Pine Cafe. Your videoconference session is 

over. The Conference Room window will close automatically and the Phone Book 

window will appear. Actually, it never disappeared; it remained on your desktop 

behind the Conference Room window. You can exit the application or use the Phone 

Book to connect to other conferences. To learn more about using the Phone Book, see 

Chapter 3.

To exit the application: 

Do one of the following:

• (Windows) Choose Exit from the File menu in the Phone Book.

• (Mac OS) Choose Quit from the File menu. 
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Using the Phone Book

The CU-SeeMe interface has two main windows: the Phone Book and the 

Conference Room. This chapter explains how to use the Phone Book and its 

components. See Chapter 4 for information on how to use the Conference Room.

Think of the Phone Book as your personal directory where you can list your friends, 

family members, business contacts, or anyone you might want to call. You can also 

think of the Phone Book as a speed dial list. You can make videoconference calls 

directly from the Phone Book.

The Phone Book includes a collection of Contact Cards. You can have a Contact 

Card for each person or place that you call. Some cards are included in CU-SeeMe 

to get you started and you can add or delete cards at any time.

You can also use the Phone Book to set up a Personal Profile for yourself. This 

profile defines information about you and your connections, such as your 

CU-SeeMe user name and communication settings. When you set up your Personal 

Profile, you create a Profile Contact Card about yourself. This card stores 

information which you can share with others.
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Components of the Phone Book
The components of the Phone Book are shown in Figure 3-1.

Figure 3-1. The Phone Book has several components

The Phone Book components are explained in the following sections, as shown in 

Table 3-1.

Table 3-1. Where to find information on Phone Book components

To find out information about... Go to...

Phone Book Menus page 3-3

Phone Book Toolbar page 3-11

Contact Cards page 3-12

Contact Groups page 3-13

Status Bar page 3-15

Menus

Toolbar

Contact Group

List of 
Contact Cards

Selected
Contact Card

Status Bar
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Phone Book Menus
You can access CU-SeeMe commands from the Phone Book menus. You activate a 

menu by clicking on it. When you do, the menu’s commands are displayed. If a 

command is not available to you, it appears dimmed. Commands in the menu that are 

followed by ellipsis (...) need more information from you before they execute. These 

commands display dialog boxes that ask you for more information. Commands in the 

menu that are followed by a triangle indicate that a submenu is available. Pause your 

mouse pointer over that command and a submenu will appear. 

Explanations and descriptions of the Phone Book commands for both Windows and 

Mac OS start on page 3-4. 

The CU-SeeMe Menu for Mac OS

There are some differences in the appearance of CU-SeeMe, depending on whether it 

is running on the Windows or Mac OS operating system. One notable difference is 

that, in Windows, the menu is located at the top of the Phone Book or Conference 

Room window. Figure 3-1 shows the menu at the top of the Phone Book in Windows. 

In the Mac OS, the menu bar is not attached to the Phone Book or to the Conference 

Room window. Instead, it is always found at the top of your screen.

The CU-SeeMe menu bar for Mac OS is shown in Figure 3-2.

Figure 3-2. The CU-SeeMe menu bar for Mac OS is always at the top of your screen

This menu bar displays all of the CU-SeeMe menu items. You can access CU-SeeMe 

commands from these menu items. Some commands may be available only when you 

are using the Phone Book, and other commands may be available only when you are 

in the Conference Room. Unavailable commands appear dimmed. (The Help menu for 

Mac OS 8 appears on the menu bar, as shown above. In earlier Mac OS versions, the 

Help menu appears as a question mark  at the top right corner of the screen.)

Commands specific to Windows or Mac OS in the following tables are noted with 

parentheses ( ). Only active Phone Book commands are included, so Mac OS 

commands that are unavailable from the Phone Book are not explained in this chapter. 

Refer to Chapter 4, Using the Conference Room, for a description of commands 

available from the Conference Room window.
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The commands under the File menu are described in Table 3-2.

Table 3-2. The commands under the File menu in the Phone Book

File Command Description

New Contact Card Assistant... Opens the Contact Card Assistant, a 
step-by-step guide to creating a new 
Contact Card. 

This command is also available by clicking 
the New Card button on the Phone Book 
Toolbar.

New Contact Card Creates a new Contact Card, which can be 
edited later.

Close (Mac OS) Disconnects you from your current 
connection and closes the Conference 
Room window. The Phone Book window 
remains on your screen. This command is 
only available when you are connected to a 
conference.

Import... Imports data and creates new Contact 
Cards.

Export > Saves the selected Contact Card to a file.

Send Mail... Sends e-mail to the address on the selected 
Contact Card. 
(Windows - Note that your e-mail program 
must be configured to use MAPI. See your 
e-mail vendor’s documentation to learn if it 
is MAPI-compliant.)
(Mac OS - CU-SeeMe will use your default 
e-mail program. To change your e-mail 
program, click the Call Options button, and 
select Phone Book. Click the Launch 
Internet Config button. Click on Helpers, 
select mailto, click the Change button, then 
click Choose Helper to choose the e-mail 
program you want to use. Click OK when 
done.)

Page Setup (Mac OS) Displays the Page Setup dialog box where 
you can change paper options such as size, 
layout and orientation. 
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Edit Menu
The commands under the Edit menu are described in Table 3-3.

Print Setup... Displays the Print Setup dialog box where 
you can change the printer and print 
options.

Print Preview (Windows) Displays the Print Preview dialog box, 
where you choose whether to preview a 
selected Contact Card or a group of Contact 
Cards.

Print... Displays the Print dialog box, where you 
choose whether to print a selected Contact 
Card or a group of Contact Cards.

1: most recent connection
2: previous connection

Lists the most recent connections you have 
made. Click on a name in this list to 
reconnect.

Exit (Windows)
Quit (Mac OS)

Exits the CU-SeeMe program.

Table 3-3. The commands under the Edit menu in the Phone Book

Edit Command Description

Undo Reverses the last text edit, such as 
renaming an entry in the list of Contact 
Cards.

Cut Removes the selected Contact Card from 
your Phone Book and puts it on the 
Clipboard.

Copy Copies the selected Contact Card to the 
Clipboard.

Paste Pastes the current content of the Clipboard.

Delete Deletes the selected Contact Card.

Select All Selects all the Contact Cards in the current 
Contact Group.

Table 3-2. The commands under the File menu in the Phone Book

File Command Description
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Edit Groups... (Mac OS) Displays the Edit Groups dialog box where 
you can add and delete Contact Groups 
and modify their attributes.

Find Displays the Find a Card dialog box where 
you can initiate a search of your Contact 
Cards.

Find Next Finds the next Contact Card, based on the 
search information you entered in the Find a 
Card dialog box.

Call Options... Displays the Call Options dialog box where 
you can change settings for Profiles, 
Listener, Security, and Phone Book options. 

This command is also available by clicking 
the Call Options button on the Phone Book 
Toolbar.

Contact Card Properties... Displays the Contact Card Editor dialog box 
where you can modify the properties of the 
selected Contact Card, including network 
settings used when calling the person or 
place on the selected card.

Current Profile... Displays the Personal Profile Editor dialog 
box, where you can modify your Personal 
Profiles. 

Test Setup... Displays the Test Setup dialog box where 
you can test and modify your video, 
microphone, speaker, and network settings.

This command is also available by clicking 
the Test Setup button on the Phone Book 
Toolbar, or from the Quick Start and Tips 
window.

Table 3-3. The commands under the Edit menu in the Phone Book

Edit Command Description
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View Menu (Windows)
Note: CU-SeeMe for Mac OS has no View menu.

The commands under the View menu are described in Table 3-4.

Call Menu
The commands under the Call menu are described in Table 3-5.

Table 3-4. The commands under the View menu in the Phone Book

View Command Description

Status Bar Turns on and off the option of viewing the 
Status Bar at the bottom of the Phone Book. 
A ✔ indicates that the option is turned on.

Contact Card Turns on and off the option of viewing 
Contact Cards in the Phone Book. A ✔ 
indicates that the option is turned on.

Groups > Displays the list of Contact Groups and the 
Edit Groups command. The current group is 
indicated with a ✔.

Directory... Displays thea list of users who are currently 
online usingCU-SeeMe and who are 
registered with an ILS server.

This command is also available by clicking 
the Directory button on the Phone Book 
Toolbar.

Table 3-5. The commands under the Call menu in the Phone Book

Call Command Description

Speed Dial current listing Calls the person or place on the selected 
Calling Card.

This command is also available by clicking 
the Speed Dial button on the Phone Book 
Toolbar.

Favorites > Displays a list of Contact Cards in your 
Favorites Contact Group. You can select a 
card from this group and call the person or 
place listed on the card.
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Manual Dial... Displays the Dial dialog box where you can 
type an IP address to make a call.

This command is also available by clicking 
the Manual Dial button on the Phone Book 
Toolbar.

Create Multicast Conference... 
(Windows)

Opens the Multicast Assistant, a 
step-by-step guide to creating a multicast 
conference.

Directory... (Mac OS) Displays the a list of users who are currently 
online using CU-SeeMe and who are 
registered with an ILS service.

This command is also available by clicking 
the Directory button on the Phone Book 
Toolbar.

Table 3-5. The commands under the Call menu in the Phone Book

Call Command Description
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Window Menu
The commands under the Window menu are described in Table 3-6.

Table 3-6. The commands under the Window menu in the Phone Book

Window Command Description

Quick Start & Tips... (Mac OS) Displays the Quick Start & Tips window.

Phone Book (Mac OS) Displays the Phone Book window. This 
command appears dimmed because the 
Phone Book is currently displayed.

Conference Room Brings the Conference Room window to the 
front. This command appears dimmed if you 
are not currently connected to a conference. 

Whiteboard (Windows) Brings the WhitePineBoard window to the 
front. This command appears dimmed if you 
are not currently in a WhitePineBoard 
session. (See the WPBoard.pdf file for more 
information.)
Chapter 3. Using the Phone Book          3-9



Ph
on

e 
B

oo
k 

M
en

us
Help Menu
The commands under the Help menu are described in Table 3-7.

Table 3-7. The commands under the Help menu in the Phone Book

Help Command Description

CU-SeeMe Help Topics Opens the CU-SeeMe Help file and displays 
the contents of the Help file.

Search for Help On (Windows) Opens the CU-SeeMe Help file and displays 
the Find page.

CU-SeeMe Events Opens a Web browser and displays a Web 
page showing a schedule of events to which 
you can connect using CU-SeeMe.

Technical Support Opens a Web browser and displays the 
White Pine Software Technical Support Web 
page.

Registration Opens a Web browser and displays the 
White Pine Software Product Registration 
Web page, allowing you to register your 
copy of CU-SeeMe online.

Quick Start & Tips Displays the Quick Start and Tips window.

About CU-SeeMe... (Windows) Displays information about your version of 
CU-SeeMe.
In the Mac OS, this command is found 
under the Apple  menu.
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Phone Book Toolbar
The Phone Book toolbar has buttons that provide shortcuts to many commands. As you 

move your mouse pointer over each button, the selected button becomes highlighted. 

You can then click the button to select it.

When you pause your mouse pointer on each button, a tool tip appears. No clicking is 

necessary. The tool tip gives you information about the function of each button.

The Phone Book toolbar buttons are explained in Table 3-8.

Table 3-8. The Phone Book toolbar buttons

Toolbar Button Description

Speed Dial

Calls the person or place on the selected 
Calling Card.

New Card

Opens the Contact Card Assistant, a 
step-by-step guide to creating a new 
Contact Card.

Manual Dial

Displays the Dial dialog box where you can 
type an IP address to make a call.

Directory

Displays a list of users who are currently 
online and registered with an ILS server.

Call Options

Displays the Call Options dialog box where 
you can change settings for Profiles, 
Listener, Security, and Phone Book options.

Test Setup

Displays the Test Setup dialog box where 
you can test and modify your video and 
audio settings.

To learn more testing your setup, see “Test 
Your Setup” on page 5-12.
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Contact Cards
A Contact Card is like a business card or a card in a rotary file. It is a convenient way 

to present and store information about a person or place, including contact 

information. The list of Contact Cards contains the names of people and places you 

might want to call. Some cards are already in this list and you can add and delete cards 

at any time.

Selected Card
You can display a Contact Card for each entry in your Phone Book. The Contact Card 

currently displayed in your Phone Book corresponds to the highlighted name in the 

Contact Card list. When you click on another Contact Card name in the list, a different 

Contact Card is displayed.

A sample Contact Card is shown in Figure 3-3.

Figure 3-3. A Contact Card allows you to store information and make connections

To learn how to create a Contact Card, see “Adding Entries in the Phone Book” on 

page 3-20. To learn how to make a call using a Contact Card, see “Making Calls from 

the Phone Book” on page 3-16.

When you create a Personal Profile (see “Creating a Personal Profile” on page 3-25), 

you also create a Profile Contact Card about yourself. You can share your Profile 

Contact Card with others and receive cards from other people. This is similar to 

exchanging business cards, except that you distribute a card file electronically, rather 

than handling paper cards. To learn more, see “Getting Information About a 

Participant” on page 4-39.
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Contact Groups
You can organize your collection of Contact Cards into categories, or Contact Groups. 

For example, you might want a group containing all of your business contacts and 

another group containing all of your social contacts. Or if you share you computer with 

other people, each person might want his/her own Contact Group. You can have the 

same name listed in more than one Contact Group. For example, you might want a 

co-worker listed in your Business Contact Group and also in your Social Contact 

Group.

Figure 3-4. The list of Contact Groups is displayed

To select Contact Groups: 

1. Click the arrow as shown in Figure 3-4. 

2. Point to the Contact Group you want to select, then click.

(Windows)

In Windows, you can also select Contact Groups from the View menu, as follows:

1. On the View menu, point to Groups.

2. Point to the Contact Group you want to select, then click.

The group you selected is now displayed in your Contact Card list and the first card in 

the list is shown as the selected card. If you select the All Contact Group, you will see 

all the Contact Cards in your Phone Book.
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To edit Contact Groups:

(Windows)

1. On the View menu, point to Groups.

2. Point to Edit Groups, then click. The Edit Groups window is displayed, as shown 
in Figure 3-5.

(Mac OS)

1. On the Edit menu, point to Edit Groups, then click.

2. The Edit Groups window is displayed, as shown in Figure 3-5. 

Figure 3-5. The Edit Groups window lets you add, delete, and modify Contact Groups

If you delete a Contact Group that contains Contact Cards, these cards will still be 

available from the All group.

To learn how to move a Contact Card from one Contact Group to another, see “Editing 

a Contact Card” on page 3-23. To learn about Parental Control, see “Using Parental 

Control” on page 3-39. 

Click to add a New Contact
Card and to assign sharing 
and Parental Control properties

Click to delete
the selected
Contact Group

Click to change the name of the selected
Contact Group and to change the
sharing and Parental Control properties

Selected Group
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Status Bar
The Status Bar, located at the bottom of the Phone Book, provides tips and information 

about your current status. When you click and hold on a toolbar button (Windows), or 

move your mouse pointer over a toolbar button (Mac OS), the Status Bar presents 

information about that button. Also, when you pause your mouse pointer on a menu 

command, the Status Bar presents information about that command. 

When you are not connected to a conference, the Status Bar displays information 

telling you which Phone Book entry you have selected. Once you have made a 

connection, the Phone Book Status Bar tells you how long you have been connected.
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Making Calls from the Phone Book
You can make videoconference calls directly from the Phone Book. To make a call, 

you can use the Speed Dial function, you can manually dial a number, or you can select 

a person to call from a list of who’s online. These methods are explained in the 

following sections.

Speed Dialing
The Speed Dial allows you to call a person or place listed on the selected Contact Card. 

To call using Speed Dial:

1. Click on a Contact Card listed in the Phone Book.

2. Click the Speed Dial button on the Phone Book toolbar. This begins your 
connection to the person or place listed on the selected Contact Card.

3. While your computer is establishing the connection, you will see the window 
shown in Figure 3-6. If you have a camera and are sending video, you will see 
your picture in this window. You will also see the Contact Card of the person or 
place to which you are connecting.

Figure 3-6. Your computer is establishing a connection
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4. Once the connection is made, this window will change to display a list of 
conferences you can join (see Figure 3-7). Select a conference, then click Join.

Figure 3-7. Choose a conference to join

5. After you select a conference, the window will display a Message of the Day as 
shown in Figure 3-8. This message is unique to each conference. Read this 
message to learn about any special rules or conditions relating to this conference.

Figure 3-8. Message of the Day

6. Click Go! to enter the conference.

In addition to these steps, there are other ways you can call using Speed Dial. These 

are described next.

If the conference is
password-protected, you
will need to enter a 
password before joining.

ACV indicates that
this conference 
supports Audio, 
Chat, and Video.

If the conference 
requires an ID, you 
will need to enter
it here.

(9/5) indicates that there
are currently 9 senders 
and 5 lurkers in this
conference.
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Other ways to call using Speed Dial:

◆ Double-click on a Contact Card in the list. 

- or - 

◆ Click on the phrase Click here to call on the selected Contact Card. 

- or - 

(Windows)

◆ Using the right mouse button (right-click), select a Contact Card in the list. A 
shortcut menu appears. Click Speed Dial. 

(Mac OS)

◆ Hold down the CONTROL key as you click on a Contact Card in the list 
(CTRL-click). A shortcut menu appears. Click Speed Dial. 

Manual Dialing
At times you might want to dial a person or place that is not already listed in your 

Phone Book. To do this, you can manually dial a number by typing the Internet 

Protocol (IP) address or the host name of the person or place you want to call. 

Note: For the connection to work, the person you are dialing must already be online 

with CU-SeeMe or the person’s Listener must be enabled and set to accept calls. (To 

learn more, see “Using the Listener” on page 3-30.) If you want to connect to a 

conference, that conference must be running when you dial it.

To call using Manual Dial:

1. Click the Manual Dial button on the Phone Book toolbar.

2. The Manual Dial dialog box appears. Type the IP address or the host name of the 
person or place you want to call. 

Optional: Click the Conference tab. Type the Conference ID and Password (if a 
Conference ID or password are required) for the conference server to which you 
want to connect. If you want to connect directly to a specific conference and 
bypass the dialog box that lists all available Conference Rooms, you need to 
specify the Conference ID number preceded by 0 (zero). For example, if you want 
to connect to Conference 2, specify the Conference ID number as 02.
3-18     CU-SeeMe User Guide



M
aking C

alls from
 the Phone B

ook
Optional: Click the Network tab to modify transmission and reception rates and 

enforce minimum reception and transmission rates for your manual call. 

3. Click Manual Dial. This begins your connection.

Calling Who’s Online
CU-SeeMe can tell you who is currently online using CU-SeeMe. You can select one 

of these names to call.

To find out who’s online:

1. Click the Directory button on the Phone Book toolbar.

2. The Directory window appears listing users who are currently online and 
registered with an ILS server. Click on a name in the Directory list.

3. Click the Speed Dial button on the Directory toolbar. This begins your 
connection.

The names appearing in the Directory list are people who are currently online using 

CU-SeeMe and have registered with an Internet Location Server (ILS). To learn more 

about registering with an ILS server, see “Registering With an Online Directory 

Service” on page 5-24.
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Adding Entries in the Phone Book
You can add new Contact Cards to the Phone Book. The easiest way to do this is using 

the Contact Card Assistant. The Contact Card Assistant guides you through the steps 

needed to create a new Contact Card.

To use the Contact Card Assistant:

1. Click the New Card button on the Phone Book toolbar.

2. The New Contact Card Assistant is displayed, as shown in Figure 3-9.

Figure 3-9. The New Contact Card Assistant makes it easy to create new Contact Cards

Follow the steps in the New Contact Card Assistant. It guides you through the creation 

of a Contact Card and adds a new entry to the Contact Card list.

You can also add a new entry in the Phone Book without using the Assistant. This is 

useful if you want to add an entry but don’t have much information to complete a 

Contact Card.

To add a simple Phone Book entry:

(Windows)

1. On the File menu, click New Contact Card.

2. A new Contact Card is created with the name Untitled. To rename this card, type 
the new name now. This new name will appear in the Contact Card List in the 
Phone Book.
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(Mac OS)

1. On the File menu, click New Contact Card.

2. A new Contact Card is created with the name Untitled. 

3. On the Edit menu, click Contact Card Properties. The Contact Card Editor 
displays. Select the General tab.

4. Type the new Nickname and click OK.

The name you typed will be added to your Contact Card List and a New Contact Card 

will be created. This card will have minimal information, and you can edit this card at 

any time to add or change information. You can also change the name of the Contact 

Card as it appears in the Contact Card list.

You can also import files which contain data that can be converted into Contact Cards.

To import data into your Phone Book:

1. On the File menu, click Import.

2. The Open dialog box is displayed, as shown in Figure 3-10.

Figure 3-10. You can import files and convert the data to Contact Cards

3. You can import several types of files. Click the arrow (as shown in Figure 3-10) 
to display a list of file types that you can import. 
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CU-SeeMe files (*.cu) and CSV files (*.csv) can be imported directly as contact cards 

into the currently selected Contact Group. Nickname files (Nickname.ini) contain the 

data from the Phone Book in earlier versions of CU-SeeMe. If you have an earlier 

version of CU-SeeMe, you can import the Nickname files to bring your old Phone 

Book entries into your new Phone Book. If you select Text files (*.txt), the Phone 

Book Import Assistant is displayed. This is a step-by-step guide to creating new 

Contact Cards using existing text files.
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Editing a Contact Card
Once you have created a Contact Card, you can edit it to add or change information, 

or you can delete the card to remove it from the Phone Book

To edit a Contact Card:

1. Select the entry in the Contact Card list.

2. On the Edit menu, click Contact Card Properties. The Contact Card Editor 
appears, as shown in Figure 3-11.

Figure 3-11. The Contact Card Editor lets you modify Contact Cards

3. Select a tab to choose what aspect of the card you want to edit. For example, the 
General tab lets you edit the Nickname text field, which is the name that appears 
in the Contact Card list. 

4. When you have completed all your edits to the Contact Card, click OK.

To delete a Contact Card:

1. Select the entry in the Contact Card list.

2. On the Edit menu, click Delete.

3. You are asked if you are sure you want to delete this card. 
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◆ (Windows) Click Yes to delete the card or No to cancel the delete process.

◆ (Mac OS) Click Delete to delete the card or Cancel to cancel the delete process.
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Creating a Personal Profile
A Personal Profile identifies you to other people on the network.Your Personal Profile 

includes your CU-SeeMe name, which is your on-screen name that others see when 

you are conferencing. When you create a Personal Profile, you also create a Profile 

Contact Card about yourself. Your Profile Contact Card is like a business card that you 

can exchange with others electronically. To learn how to exchange Contact Cards with 

others, see “Getting Information About a Participant” on page 4-39. 

If you choose to videoconference on public conferences, your Profile Contact Card can 

be seen and saved by anyone with CU-SeeMe; therefore, you should be careful what 

information you choose to display on your Profile Contact Card. For example, if you 

do not want strangers to have your phone number, then you should not list it on your 

Contact Card. 

Your Personal Profile also contains information about Parental Control options, and 

your computer setup. To learn more about Parental Control, see “Using Parental 

Control” on page 3-39.

You can create one or more Personal Profiles. For example, you might want one 

profile for personal use and one for home use, or you might want different profiles for 

different members of your family. 

To create a Personal Profile:

1. Be sure that you are not connected to a conference when you create your Personal 
Profile. The Phone Book window should be your active window. If it is not, then 
click on the Phone Book window to make it the active window.

2. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click. 
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3. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed), 
as shown in Figure 3-12.

Figure 3-12. You can create and edit your Personal Profile

4. Click New.

5. The Personal Profile Assistant is displayed, as shown in Figure 3-13.

Figure 3-13. The Personal Profile Assistant makes it easy to create a Personal Profile

Click to create a new profile.

Click to edit the selected profile.

Click to create a profile which is
a duplicate of the selected one.
You can then edit this new 
profile.

Delete the selected profile.

Click in the check box
to use this profile for
your next videoconference.

Click on a profile name
to select it.

Select this to be prompted
to choose a profile
each time you start
CU-SeeMe.
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Follow the steps in the Personal Profile Assistant. It guides you through the creation 

of a Personal Profile including a Profile Contact Card. You can repeat these steps to 

add additional profiles.
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Editing a Personal Profile
You can edit your profiles if you want to add or change any information. For example, 

you might want to change your CU-SeeMe name, which is your on-screen name that 

others see when you are conferencing. If you are currently connected using the profile 

that you want to edit, you’ll need to disconnect first.

To edit a Personal Profile:

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed), 
as shown in Figure 3-12.

3. Click Edit.

4. The Personal Profile Editor appears, as shown in Figure 3-14.

Figure 3-14. The Personal Profile Editor lets you modify your profile

5. Select a tab to choose what aspect of the Personal Profile you want to edit. For 
example, the General tab lets you edit your CU-SeeMe name, which is the user 
name that appears when you conference with others.

6. When you have completed all your edits to the Personal Profile, click OK.
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To delete a Personal Profile:

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed), 
as shown in Figure 3-12. Select the profile you want to delete.

3. Click Delete.

4. You are asked if you are sure you want to delete this profile. 

◆ (Windows) Click Yes to delete the profile or No to cancel the delete process.

◆ (Mac OS) Click Delete to delete the profile or Cancel to cancel the delete 
process.
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Using the Listener
The Listener is a program that lets you know if someone is trying to call your computer 

for a videoconference, even when CU-SeeMe is not running or when you are already 

connected to a conference or another call. It will listen for incoming calls and it will 

notify you. You can accept, ignore, or refuse the call. 

The Listener is automatically turned on when CU-SeeMe is running. This means that 

if you are in a videoconference and someone else calls you, you will be notified of the 

call so you can accept it or not. If you accept it, you will be disconnected from your 

current videoconference because you cannot be connected to two conferences 

simultaneously. You will then be connected to the new, incoming call.

Enabling the Listener
If you want to have the Listener running even when CU-SeeMe is not running, you will 

need to enable the Listener to run as a start-up program. This means that the Listener 

will start automatically when Windows or Mac OS starts on your computer. In this 

scenario, you will be notified of an incoming call even when CU-SeeMe is not 

running. You can accept or deny the call. If you accept the call, the Listener 

automatically starts CU-SeeMe so you can begin conferencing with the caller.

To enable the Listener:

1. Click the Call Options button on the Phone Book toolbar. Point to Listener, then 
click. 
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2. The CU-SeeMe Call Options dialog box appears (with the Listener tab displayed), 
as shown in Figure 3-15.

Figure 3-15. You can enable the Listener to notify you of incoming calls

3. Select the check box labeled Run listener at startup, as shown in Figure 3-16.

Figure 3-16. You can enable the Listener to run even when you are not running CU-SeeMe

4. The button next to this check box toggles between two modes. It says either 
Suspend listening now or Resume listening now. If you decide that you want to 
stop running the Listener temporarily, click Suspend listening now. When you 
click it, the button changes to say Resume listening now. The label on the button 
tells you what will happen when you click the button. When you want to resume 
using the Listener, click the button again. For now, the button should say Suspend 
listening now.

5. The next time you restart your computer, the Listener will be enabled to run even 
when CU-SeeMe is not in use. 

Listener Enabling
lets you turn the
Listener on or off

Listener Active Filters
let you block calls
from specific users

Default Listener Settings
lets you change the
way you are notified
of incoming calls, define
how the Listener 
responds to calls you 
don’t answer, and 
customize a ring

Select this to have the 
Listener run every time
you start your computer.

Click to stop running 
the Listener 
temporarily. 
Click again to resume
running the Listener.
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(Windows) 

You will see the Listener icon in the Windows Taskbar, letting you know that the 

Listener is running. To turn the Listener off, right-click on the icon in the Taskbar, 

point to Disable Listening, then click. The icon changes to indicate that the 

Listener is turned off.

Changing Listener Default Settings
The Listener is set up to notify you of all incoming calls by displaying a Notification 

dialog box, and ringing ten times. If you do not accept an incoming call within ten 

rings, the call is automatically refused. You can change these default settings.

To change the Listener default settings:

1. Click the Call Options button on the Phone Book toolbar. Point to Listener, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Listener tab displayed), 
as shown in Figure 3-15.

3. At the bottom of this dialog box is a section called Default Listener Settings. 
Click the Default Settings button to display the Listener Default Settings dialog 
box, shown in Figure 3-17.
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4. There are two sections of this tab that you can modify. One is a section called Get 
my attention, which defines how you want to be notified of incoming calls, and 
the other section is called Call response, which defines how you want the Listener 
to respond if you don’t answer the incoming call. These are explained in the 
following sections.

Figure 3-17. You can modify the default settings of the Listener

Get my attention lets you
select a notification 
method for incoming calls

Call response lets you
choose a response if
you don’t answer an
incoming call
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Modifying the Notification Method
Using the Listener Default Settings dialog box, you can define how you want to be 

notified of incoming calls. In the section of the Listener Default Settings dialog box 

called Get my attention, you can select the sound you want to hear when you are 

notified of a call. This section is shown in Figure 3-18.

Figure 3-18. You can define how you want to be notified of incoming calls

You can select one of the following ring options:

◆ No ring

◆ Standard ring

◆ Distinctive ring

If you select Distinctive ring, you then need to click the Browse button to find a .wav 

file on your hard disk. You can browse to the CU-SeeMe folder (in Windows, usually 

on the C: drive at C:\Program Files) then the sounds folder, and finally select 

conflist.wav or any other .wav file. 

Use the Play button to listen to the sound. This sound will replace the standard ring to 

notify you of an incoming call.

(Windows)

• If the Open Notify Dialog check box is selected, you will also see a dialog box 
whenever you receive an incoming call. This dialog box makes it easy to 
respond to the call.

• If the Flash check box is selected, a portion of your screen will flash to get your 
attention and let you know that you are being called. If you select Flash, then 
you can use the drop-down list to select which portion of the screen will flash.

You can select whether
you want the Listener to 
ring when you are called.
Then select the ring sound.
Here a Distinctive ring
is selected.

Click the Browse button
to select a ring from the
CU-SeeMe Sounds folder
or select any .wav sound.
 

Click to play (and stop)
the selected sound.

Select to open a dialog 
box to notify you when 
you are being called. 

Select to have a part of 

the 

your screen flash when
you are being called. 
Use the drop-down list
to select which part of 
your screen will flash.

(Windows only)

(Windows only)
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Modifying the Listener Response
Using the Listener Default Settings window, you can define how you want the Listener 

to respond if you don’t answer the incoming call. In the section of the Listener Default 

Settings dialog box called Call response (shown in Figure 3-19), you can select the 

following response options:

◆ Ring forever

This means that the Listener will continue to ring until the caller disconnects.

◆ Ignore this call with no message

This means that calls will automatically be refused and the caller will receive no 
feedback from your computer. If this is selected, you will not be notified of 
incoming calls.

◆ Refuse call after x rings with message

This means that you can define how many times the Listener will ring before 
refusing calls. If you type a message into the box below this choice, that message 
will be sent to the caller once the call is refused. For example, you can send the 
following message to your caller: 

“I am not at my computer right now. Please call again later.”

Figure 3-19. You can define how the Listener will respond if you don’t answer the call

Choose how CU-SeeMe
should respond when
you don’t answer an
incoming call. Here, the 
call will be refused after 
10 rings and a message 
will be displayed to the 
caller.

Type the message that
you want to caller to
receive.
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Creating Listener Active Filters
There may be times when you don’t want the Listener to use the default settings. For 

example, you might want to block out calls from one particular caller, but receive 

notification when anyone else calls. Or you might want to be notified of calls from 

only a small group of special friends. You can override the default settings by creating 

Listener Active Filters.

To create Listener Active Filters:

1. Click the Call Options button on the toolbar. Point to Listener, then click.

2. The CU-SeeMe Call Options dialog box appears (with the Listener tab displayed), 
as shown in Figure 3-15.

3. There is a section of this dialog box called Listener Active Filters. Click the New 
button to create a new filter. The New Listener Filter dialog box appears, as shown 
in Figure 3-20.

Figure 3-20. You can customize the Listener for specific incoming calls using filters

Use this section to define
whose calls will be 
filtered.
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You can create a filter that will override the default Listener settings. For example, 

using the sample filter shown in Figure 3-21, if a user with the CU-SeeMe name of 

Jason tries to call you, the call will automatically be refused and Jason will receive the 

following message: 

“I am not accepting your call at this time.”

Figure 3-21. This sample Listener Filter will stop incoming calls from Jason

You can also use the Listener Filter to notify you of certain calls even if your default 

setting ignores all calls. Simply create a Listener Filter to accept a call from a specific 

user. The filters always override the default settings. 

If you create multiple filters, CU-SeeMe implements the filters in sequence, from the 

top of the list to the bottom. You can change the sequence of the filters, using the up 

and down arrows next to the list of filters, as shown in Figure 3-15.

Calls from Jason will be
filtered

Jason will receive this
message when his call
is refused

Calls from Jason 
will be refused
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Answering an Incoming Call
If you have selected the default Listener settings, the Listener Status window (see 

Figure 3-22) appears when another user is calling CU-SeeMe on your computer.

Figure 3-22. The Listener Status dialog box notifies you of incoming call

You can choose to accept the call or you can reject the call. You can reject the call in 

two ways. If you click Ignore, the caller will not connect to your computer. If you click 

Refuse, the caller will not connect to your computer and, if you defined a message in 

the Listener Default Settings dialog box (see Figure 3-17), that message will be sent to 

the caller.

The CU-SeeMe user name
of the caller is displayed

Select this to receive the 
caller’s video when
connected

Select this to transmit your 
video when connected

Click here to ignore the call Click here to refuse the call
and send a message (if defined)

Click here to accept the call

Click to display
additional options
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Using Parental Control
CU-SeeMe parental control allows you to put restrictions on the CU-SeeMe calls that 

are made from your computer and the calls accepted by your computer. 

Configuring Parental Control
You can configure parental control to restrict other users from accessing all the 

features of CU-SeeMe. You decide which features you want disabled. 

To configure parental control:

1. Click the Call Options button on the Phone Book toolbar. Point to Security, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Security tab displayed), 
as shown in Figure 3-23.

Figure 3-23. You can configure and enable parental control

3. Click the button labeled Configure Parental Control Restrictions.The Parental 
Control Restrictions window appears. 

 

Chapter 3. Using the Phone Book          3-39



U
si

ng
 P

ar
en

ta
l C

on
tr

ol
4. Click the Communications tab (see Figure 3-24).

Figure 3-24. You can restrict incoming and outgoing calls, as well as multicast conferencing

5. Click the items you want to allow access to. 

6. Click OK.

(Mac OS)

Because CU-SeeMe for Mac OS does not support IP Multicast conferences, the Allow 
Multicast option is dimmed.
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7. Click the Usage tab (see Figure 3-25).

Figure 3-25. You can restrict access to Web launching and Phone Book features

8. Click the items to indicate the privileges you want to allow. 

9. Click OK.

10. Click the Profiles tab (see Figure 3-26).

Figure 3-26. You can restrict a user from changing profiles
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11. Click the items to indicate the privileges you want to allow. 

12. Click OK. You are returned to the Security tab.

13. Click OK again.

You have now configured parental control options; however, you have not yet enabled, 

or turned on parental control. To do this, read the following section.

Enabling Parental Control
Parental control is password-protected. A parent can set controls which can be turned 

on or off and modified only by someone who knows the password.This prevents others 

from tampering with the control configurations you chose in the previous section.

To create a password:

1. Click the Call Options button on the Phone Book toolbar. Point to Security, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Security tab displayed), 
as shown in Figure 3-23.

3. If you have not yet created a password, you will need to do this. Click the Create 
Password button. The New Parental Control Password dialog box appears, as 
shown in Figure 3-27.

Figure 3-27. Enter or create a password to protect the parental controls

4. Enter an existing password or create a new password. Then click OK.

 

Enter an existing password here

To create a new password, type it here
Type the new password again, to confirm it
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To enable parental control:

1. In the CU-SeeMe Call Options dialog box (see Figure 3-23), click Enable 
Parental Control.

2. Type your password in the Parental Control Password dialog box. This turns on 
parental control.

3. Repeat this step to turn off parental control.

4. Click OK when you are done.
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Multicast Conferences (Windows only)
CU-SeeMe allows you to conference with multiple users (Windows users only at this 

time) in a multicast conference. In a multicast conference, you send a stream of video, 

audio, Chat, WhitePineBoard, and conference control data over a network to many 

users simultaneously. Joining a multicast conference is similar to connecting to a 

conference hosted on a conference server. Only users with CU-SeeMe Version 2.1 for 

Windows (or later) can participate in a multicast conference.

Once the multicast conference has been created (see “Creating a Multicast Conference 

(Windows only)” on page 3-46), any user can join the multicast conference by 

selecting the conference from the Phone Book. Users can also join by connecting 

(point-to-point) to any participant who has already joined the conference. The 

Participants List will not display any participants until a user (in addition to the 

conference creator) connects to the IP address of the multicast conference.

CU-SeeMe multicast conferences are “loosely coupled” which means that participants 

can join the multicast, or disconnect from the multicast at any time. Even the creator 

of the conference can disconnect and the conference will continue to exist as long as 

more than one user is still connected to this multicast. When all participants disconnect 

from the multicast conference, then that conference no longer exists.

Multicast is a special TCP/IP protocol for sending data over an IP network from a 

single source to many recipients. This requires a TCP/IP stack that supports multicast. 

The Microsoft VxD TCP/IP stack, which is included with the Windows 95 and 

Windows NT operating systems, supports multicast.

Because multicast is a relatively new TCP/IP protocol, not all routers, bridges, and 

gateways support multicast. Therefore you may not be able to multicast over the 

Internet or over your LAN or WAN. Many modem users may find that they are not 

able to join or create multicast conferences. If you want to use multicast over your 

corporate LAN or WAN, check with your Systems Administrator or your Internet 

Service Provider first.

Your ability to participate in a multicast conference also depends on the network 

interface card (commonly called a NIC, or an Ethernet card) installed in your 

computer. Please consult your hardware supplier and Internet Service Provider to find 

out if they support multicast conferencing. For more information on compatible 

network interface cards check the CU-SeeMe Frequently Asked Questions on the 

World Wide Web at http://support.wpine.com/cuseeme.
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There are two types of multicast conferences: 

◆ Group Conference 

This is an interactive conference where all users who are connected can send and 
receive audio and video, and can use the other features of CU-SeeMe, such as 
Chat and the WhitePineBoard. (See the WPBoard.pdf file for details.)

◆ Cybercast 

This is a one-way conference where only the conference creator can send out 
video and audio. Others who are connected can see and hear the “cybercasted” 
audio and video, but they cannot send audio and video.

Multicast conferences have no limit to the number of participants that can join. 

However, due to bandwidth considerations, a multicast group (interactive) conference 

should generally not exceed100 participants. A multicast cybercast conference 

(one-way) has no limits on the number of participants. Multicast cybercast conferences 

will not have a Participants List. However the conference creator can see how many 

participants are viewing the broadcast. 

Enabling Multicast (Windows only)
Before you can create or join a multicast conference, you must be sure that your 

Personal Profile is set to enable a multicast.

To enable multicast:

1. Disconnect from any conference or point-to-point chat that is running. Click the 
Call Options button on the Phone Book toolbar. Point to Profiles, then click.

2. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed), 
as shown in Figure 3-12.

3. Click Edit.

4. The Personal Profile Editor appears, as shown in Figure 3-14. Select the General 
tab.
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5. Select the Enable Multicast Connections check box to turn on the ability to 
participate in multicast conferences. When you select this check box, CU-SeeMe 
will check to see if a TCP/IP stack with multicast support is installed in your 
computer. If this stack is found, then this box will remain selected. If an 
appropriate TCP/IP stack is not found, this box will revert to being unselected and 
you will not have the option of creating or joining a multicast conference.

6. Click OK.

Creating a Multicast Conference (Windows only)
If you have multicast-capable network connections and you have multicast enabled, 

you can create a multicast conference. CU-SeeMe includes a Multicast Assistant to 

guide you.

To create a multicast conference:

1. From the Call menu, click Create Multicast Conference. 

2. The Multicast Conference Assistant is displayed, as shown in Figure 3-28. 

Figure 3-28. The Multicast Conference Assistant makes it easy to create a multicast conference 

3. Click Next to define the type of multicast conference you want to create.
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4. Click the Group conference option to create an interactive conference where all 
participants can exchange video and audio, Chat, and share WhitePineBoard 
workbooks.

- or -

Click the Broadcast conference option to create a one-way conference (a 
cybercast) where only you can send video and audio. Participants who connect to 
this conference can see and hear you, but they cannot send data. 

5. Select an area from the Area drop-down list. These areas determine how far your 
multicast conference will reach. Before selecting Region, Continent, or World as 
your multicast conference area, contact your network manager to ask whether you 
have the appropriate Internet access.

• Subnet - Stay within your local area network (LAN). Your multicast will not 
go through routers.

• Site - Stay within your Wide Area Network (WAN). For example, your 
multicast may stay within your corporate network. This will work only if your 
WAN has multicast routers.

• Region - Extend to the Internet for a defined Time to Live (TTL). Your 
multicast will be limited to a defined area on the Internet. Click Advanced 
Configuration to define the TTL.

• Continent - Extend to the Internet for an extended Time to Live (TTL). Your 
multicast will be limited to a defined area on the Internet. A Continent will have 
a greater Time to Live value than a Region. Click Advanced Configuration to 
define the TTL.

• World - Extend to the widest range for a defined Time to Live (TTL). Your 
multicast will be capable of extending globally. Click Advanced 
Configuration to define the TTL.

6. Click Next. Click Next again to enter information to describe the conference.

7. Type a conference name. This will appear in the Phone Book of any CU-SeeMe 
user who is able to connect to your conference. See“Joining a Multicast 
Conference (Windows only)” on page 3-48 for information about how multicast 
conferences appear in the Phone Book.

8. Type a description of your conference. This will appear on a Contact Card for 
your multicast conference. This Contact card will also appear in the Phone Book 
of any CU-SeeMe user who is able to connect to your conference.

9. Click Next. Click Next again to enter contact information.
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10. Contact information allows other users to contact you for more information about 
the multicast conference you have created. This information is optional. You can 
type your name, a URL for your Web page, and your phone number. Your Web 
page could include information about your multicast conference. Your phone 
number allows people to contact you directly via the telephone. Remember to 
include your complete phone number because participants in your conference 
could be located anywhere in the world.

11. Click Next. You are now presented with a Contact Card for your conference. This 
will automatically appear in the Phone Book of any user who is able to connect to 
your conference.

12. Click Finish. This closes the Multicast Assistant and begins the multicast 
conference.

Joining a Multicast Conference (Windows only)
If you have multicast-capable network connections and you have multicast enabled, 

you can join multicast conferences. All multicast conferences that are available to you 

are listed in your Phone Book. 

To join a multicast conference:

1. On the View menu, point to Groups.

2. Point to the Multicast Contact Group, then click.

3. The multicast group is now displayed in your Contact Card list and the first card 
in the list is shown as the selected card. You can call a multicast conference as you 
would call any other conference. (See “Making Calls from the Phone Book” on 
page 3-16.) If this list is empty, it means that no multicast conferences are 
currently available to you. 
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Chapter 4

Using the Conference 
Room

The CU-SeeMe interface has two main windows: the Phone Book and the 

Conference Room. This chapter explains how to use the Conference Room. See 

Chapter 3 for information on how to use the Phone Book. To enter the Conference 

Room, you must make a call from either the Phone Book (see “Making Calls from 

the Phone Book” on page 3-16) or the Quick Start window (see “Connecting to the 

White Pine Cafe” on page 2-10).

The Conference Room window is where videoconferencing takes place. Think of it 

as a virtual meeting room where you see and talk to others. Whether you are 

connected in a point-to-point conference, a group conference, or a cybercast, you 

will be doing it in the Conference Room.

The Conference Room window was introduced in Chapter 2. This chapter describes 

additional features.
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Components of the Conference Room
The components of the Conference Room window are shown in Figure 4-1.

Figure 4-1. The Conference Room window

The components are explained in the following sections, as shown in Table 4-1.

Table 4-1. Where to find information on Conference Room components

To find out information about... Go to...

Conference Room Menus page 4-3

Conference Room Toolbar page 4-10

Participants List page 4-12

Video Windows page 4-19

Chat Window page 4-26

Audio Controls and Indicators page 4-36

Status Bar page 4-38

Menus

Toolbar

Participants
List

Audio 
controls and
indicators

Video windows

Chat window

Status bar
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Conference Room Menus
You can access CU-SeeMe commands from the Conference Room menu. You activate 

a menu by clicking on it. When you do, the menu’s commands are displayed. If a 

command is not available to you, it appears dimmed. Commands in the menu that are 

followed by ellipsis (...) need more information from you before they execute. These 

commands display dialog boxes that ask you for more information. Commands in the 

menu that are followed by a triangle indicate that a submenu is available. Pause your 

mouse pointer over that command and a submenu will appear. 

Explanations and descriptions of the Conference Room commands for both Windows 

and Macintosh start on page 4-4. 

The CU-SeeMe Menu for Mac OS

There are some differences in the appearance of CU-SeeMe, depending on whether it 

is running on the Windows or Mac OS operating system. One notable difference is 

that, in Windows, the menu is located at the top of the Phone Book or Conference 

Room window. Figure 4-1 shows the menu at the top of the Conference Room in 

Windows. In the Mac OS, the menu bar is not attached to the Phone Book or to the 

Conference Room window. Instead, it is always found at the top of your screen.

The CU-SeeMe menu bar for Mac OS is shown in Figure 4-2.

Figure 4-2. The CU-SeeMe menu bar for Mac OS is always at the top of your screen

This menu bar displays all of the CU-SeeMe menu items. You can access CU-SeeMe 

commands from these menu items. Some commands may be available only when you 

are using the Phone Book, and other commands may be available only when you are 

in the Conference Room. Unavailable commands appear dimmed. (The Help menu for 

Mac OS 8 appears on the menu bar, as shown above. In earlier Mac OS versions, the 

Help menu appears as a question mark at the top right corner of the screen.)

Commands specific to Windows or Mac OS in the following tables are noted with 

parentheses ( ). Only active Conference Room commands are included, so Mac OS 

commands that are unavailable from the Conference Room are not explained in this 

chapter. Refer to Chapter 3, Using the Phone Book, for a description of commands 

available from the Phone Book window.
Chapter 4. Using the Conference Room          4-3



C
on

fe
re

nc
e 

R
oo

m
 M

en
us
File Menu
The commands under the File menu are described in Table 4-2.

Table 4-2. The commands under the File menu in the Conference Room

File Command Description

Close Disconnects you from your current 
connection and closes the Conference 
Room window. The Phone Book window 
remains on your screen.

Save Chat... Displays a dialog box where you can save 
the contents of the Upper pane of the Chat 
window to a file. 

Save Chat As Displays a dialog box where you can save 
the contents of the Upper pane of the Chat 
window to a file that you can rename.

Send Mail... Opens your default e-mail program. (Note 
that your e-mail program must be 
configured to use MAPI. See your e-mail 
vendor’s documentation to learn if it is 
MAPI-compliant.)

Page Setup... Displays the Print Setup dialog box where 
you can change the printer and print 
options.

Print... Displays the Print dialog box, where you 
can print Chat text or video images.

Exit (Windows)
Quit (Mac OS)

Disconnects you from your current 
connection and exits the CU-SeeMe 
program. 
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Edit Menu
The commands under the Edit menu are described in Table 4-3.

Table 4-3. The commands under the Edit menu in the Conference Room

Edit Command Description

Undo Reverses the last text edit in the Chat 
window input pane.

Cut Cuts the selected Chat text and puts it on 
the Clipboard.

Copy Copies the selected Chat text to the 
Clipboard.

Paste Pastes the current content of the Clipboard.

Delete Deletes the selected Chat text.

Select All Selects all the Chat text.

Call Options (Mac OS) Displays the Call Options dialog box where 
you can change settings for Profiles, 
Listener, Security, and Phone Book options. 

This command is also available by clicking 
the Call Options button on the Phone Book 
Toolbar.

Customize... Displays the Customize dialog box where 
you can change settings for the Conference 
Room including video layout, Chat, audio, 
video, network and more. 

This command is also available by clicking 
the Customize button on the Conference 
Room toolbar.

Current Profile... (Mac OS) Displays the Personal Profile Editor dialog 
box, where you can modify your Personal 
Profiles. (If you are currently connected to a 
conference, you will have to disconnect 
from the conference before modifying your 
current profile.)
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Call Menu (Mac OS)
Note: The Conference Room in CU-SeeMe for Windows has no Call menu. 

The commands under the Call menu are described in Table 4-4.

Table 4-4. The commands under the Call menu in CU-SeeMe for Mac OS

Call Command Description

Favorites > Displays a list of Contact Cards in your 
Favorites Contact Group. You can select a 
card from this group and call the person or 
place listed on the card.

Manual Dial... Displays the Dial dialog box where you can 
type an IP address to make a call. (If you 
are currently connected to a conference, 
you will have to disconnect from the 
conference before dialing another.) 

Directory Displays a list of users who are currently 
online using CU-SeeMe and are registered 
with an ILS server. 
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Conference Menu
The commands under the Conference menu are described in Table 4-5.

Table 4-5. The commands under the Conference menu in the Conference Room

Conference Command Description

Speak To > Displays a list of conference participants. 
Click on a name in the list to send audio to 
only that person. If you do not select a 
name, you will send audio to everyone in 
the conference. Windows users must have 
a sound card and microphone to send 
audio.

This command is also available by clicking 
the Speak To button on the Conference 
Room toolbar.

Mute > Displays a list of conference participants. 
Click on a name in the list to stop 
receiving audio from that person. If you do 
not select a name, you will receive audio 
from everyone in the conference. 
Windows users must have a sound card 
and speakers to receive audio.

Chat to > Displays a list of conference participants. 
Click on a name in the list to send Chat 
text to the selected person only. This is 
called Private Chat. If you do not select a 
name, you will send Chat to everyone in 
the conference. This is called Public Chat.

Video > Displays a list of conference participants 
who are sending video. Click on a name in 
the list to display that participant’s video.

This command is also available by clicking 
the Video button on the Conference 
Room toolbar.

Get Contact Card of > Displays a list of conference participants 
who have Contact Cards available. Click 
on a name in the list to get that person’s 
contact card. 

Get Participant Info (Mac OS) Displays the information window for a 
selected participant.
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Window Menu
The commands under the Window menu are described in Table 4-6.

Hold Temporarily freezes the audio and video 
that you send and receive. It does not 
freeze Chat text. 

Speakers Turns your speakers on and off.

Hang Up Disconnects you from the current 
conference and closes the Conference 
Room.

This command is also available by clicking 
the Hang Up button on the Conference 
Room toolbar.

Table 4-6. The commands under the Window menu in the Conference Room

Window Command Description

Quick Start & Tips... (Mac OS) Displays the Quick Start & Tips window.

Phone Book Displays the Phone Book window. 

This command is also available by clicking 
the Phone Book button on the Conference 
Room toolbar.

WhiteBoard (Windows) Starts the WhitePineBoard program. Brings 
the WhitePineBoard window to the front if 
you are currently running the 
WhitePineBoard. (For details, refer to the 
WPBoard.pdf file.)

This command is also available by clicking 
the WhiteBoard button on the Conference 
Room toolbar.

Table 4-5. The commands under the Conference menu in the Conference Room

Conference Command Description
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The commands under the Help menu are described in Table 4-7.

Table 4-7. The commands under the Help menu in the Conference Room

Help Command Description

CU-SeeMe Help Topics Opens the CU-SeeMe Help file and displays 
the contents of the Help file.

Search for Help On (Windows) Opens the CU-SeeMe Help file and displays 
the Find page.

CU-SeeMe Events Opens a Web browser and displays a Web 
page showing a schedule of events to which 
you can connect with CU-SeeMe.

Technical Support Opens a Web browser and displays the 
White Pine Software Technical Support Web 
page.

Registration Opens a Web browser and displays the 
White Pine Software Product Registration 
Web page, allowing you to register your 
copy of CU-SeeMe online.

Quick Start & Tips Displays the Quick Start and Tips window.

About CU-SeeMe... (Windows) Displays information about your version of 
CU-SeeMe.
In the Mac OS, this command is found 
under the Apple  menu.
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Conference Room Toolbar
The Conference Room toolbar has buttons that provide shortcuts to many commands. 

As you move your mouse pointer over each button, the selected button becomes 

highlighted. You can then click the button to select it.

When you pause your mouse pointer on each button, a tool tip appears. No clicking is 

necessary. The tool tip gives you information about the function of each button.

The Conference Room toolbar buttons are explained in Table 4-8.

Table 4-8. The Conference Room toolbar buttons

Toolbar Button Description

Phone Book

Displays the Phone Book window. 

 WhiteBoard

Starts the WhitePineBoard program. 
(Windows only)

Video

Displays a list of conference participants 
who are sending video. Click on a name in 
the list to display that participant’s video.

Also allows you to fill all available video 
window frames with video images (Open 
All), or close all video images on your 
screen (Close All). 

 Speak To

Displays a list of conference participants. 
Click on a name in the list to send audio to 
only that person. If you do not select a 
name, you will send audio to everyone in 
the conference. Windows users must have a 
sound card and microphone to send audio.

Customize

Displays the Customize dialog box where 
you can change settings for the Conference 
Room including video layout, Chat, audio, 
video, network and more. 
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Hang Up

Disconnects you from the current 
conference and closes the Conference 
Room.

Table 4-8. The Conference Room toolbar buttons

Toolbar Button Description
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The Participants List shows the names of the people currently in the conference. In 

addition to listing names, the Participants List shows information about each of the 

participants, such as whether the person is a sender (sending a video image) or lurker 

(not sending a video image), is watching your video, and more. Once you understand 

which participants are senders and lurkers, you can decide whose video images you 

want to display on your screen. You can try to display the video image of a lurker, but 

instead of a picture you will get a blank frame with a message telling you that the 

chosen participant has “No Video Stream.”

To learn how to display the video images of participants in a conference, see “Seeing 

Video Images” on page 4-19. To learn how to change your own status from a sender 

to a lurker (and back again) see “Being Seen” on page 4-21.

Participants List Views
The Participants List displays the CU-SeeMe user name of each person in the 

conference, as well as status information about each participant. You can choose 

whether to view the Participants List as a detailed list, or as a group of large or small 

icons. By default, CU-SeeMe displays the Participants List as a detailed list. Try each 

view and choose the one that you prefer.

If you choose to view the Participants List as icons, then the information about each 

participant is conveyed using pictures. These pictures, or icons, illustrate whether the 

person is a sender or lurker, is watching your video image, and more. 

To learn more about the detailed list view, see “Participants List Viewed as a Detailed 

List” on page 4-14. To learn more about the small icon view, see “Participants List 

Viewed as Small Icons” on page 4-16. To learn more about the large icon view, see 

“Participants List Viewed as Large Icons” on page 4-17. 
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To change the Participants List view:

1. Click the Customize button on the Conference Room toolbar. Point to General, 
then click. The Customize dialog box appears (with the General tab displayed), as 
shown in Figure 4-3..

Figure 4-3. You can choose from three Participant List views

2. Select a Participants List view (as list, as small icons, or as large icons).

3. Click OK when you are done. The selected Participants List is now displayed in 
your Phone Book.

(Mac OS)

The Mac OS version of the General tab on the Customize dialog box does not have the 

Always use these settings for this connection check box.

Select how you 
want to view the
Participants List
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Participants List Viewed as a Detailed List
By default, CU-SeeMe displays the Participants List as a detailed list. The detailed list 

shows the names of all the participants in the conference. It also shows icons, 

organized in columns, which indicate different things about the status of each 

participant. These icons are explained in Table 4-9.

Table 4-9. Icons in the detailed list

This icon... Indicates this about the participant...

This participant is sending video.

This participant’s video is currently displayed on your screen.

This participant is currently watching your video.

This participant and you are both watching each other’s 
videos.

This participant is hearing audio that you send.

This participant can send audio.

You have muted this participant. Therefore, you will not hear 
any audio sent by this participant.
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Figure 4-4 shows how these icons appear in the Participants List.

Figure 4-4. The Participants List shown as a detailed list

You can click on the heading at the top of each column to sort the list:

◆ Click on the Participant heading to sort the list so that the user names appear 
alphabetically. 

◆ Click on the  heading to sort the Participants List so that all the senders are 
grouped at the top and all the lurkers are grouped at the bottom. 

◆ Click on the  heading to group all the users who are currently seeing you. 

◆ Click on the  heading to group all the users who have speakers turned on. 

◆ Click on the heading to group all the users who can send audio.

Your name will always appear at the top of the list. You can extend the columns in the 

detailed list to show additional information about the participants. Only the Is Sending 

Video icon will be displayed for your name.

To see extended information:

1. (Windows) Using the right mouse button (right-click), click on a blank area of the 
Participants List, such as the area below the list of names. A shortcut menu 
appears.

Is sending 
video

Who’s seeing
whom

Is hearing 
you

Can send
audio

He is seeing you
(this person has your
video displayed)

You are seeing him
(this person’s video is
displayed on your screen)

You are both seeing
each other

You have muted this person

Bill’s name is 
underlined and in 
bold to indicate he 
was the last person
to send audio
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(Mac OS) Hold down the CONTROL key as you click on a blank area of the 
Participants List, such as the area below the list of names. A shortcut menu 
appears.

2. Point to Extended Info, then click.

3. The Participants List now displays additional columns of information. You may 
need to scroll the Participants List to the right or resize the Participants List to see 
all the information. (See “Resizing the Participants List” on page 4-18 to learn 
how to enlarge the Participants List.)

You can also display the extended information by selecting the Show extended 
information check box shown in Figure 4-3.

The new columns of information show the video and audio codec used, as well as the 

IP Address of each participant. To hide the extended information, repeat the previous 

steps (or deselect the Show extended information check box shown in Figure 4-3).

To learn how to view the Participants List in alternate ways, see “Participants List 

Views” on page 4-12.

Participants List Viewed as Small Icons
When you choose to view the Participants List as small icons, a small icon appears 

next to each name in the Participants List. Understanding these icons will enable you 

to know who is seeing you, hearing you, and more. Figure 4-5 explains the 

components of a small icon that represents a participant in a conference.

Figure 4-5. The components of the small icon used in the Participants List

Figure 4-6 shows the meaning of the small icons used to represent you (the local 

participant) in a conference.

Figure 4-6. These icons represent you (the local participant) in the small icon view

Is sending video

Is looking at you

Is listening to you

A box around the icon
means that this person is
currently displayed on 
your screen

This represents you when your video
 image is not displayed on your screen

This represents you when your video
 image is displayed on your screen
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Participants List Viewed as Large Icons
When you choose to view the Participants List as large icons, a large icon appears over 

each name in the Participants List. Understanding these icons will enable you to know 

who is seeing you, hearing you, and more. Figure 4-7 explains the components of a 

large icon that represents a participant in a conference.

Figure 4-7. The components of the large icon representing a remote participant

Figure 4-8 shows the meaning of the large icons used to represent you (the local 

participant) in a conference.

Figure 4-8. These icons represent you (the local participant) in the large icon view

Moving the Participants List (Windows only)
The Participants List can be moved from the left side of the Conference Room to the 

right side. It can also be dragged out of the Conference Room window, becoming a 

separate, floating window. 

To move the Participants List:

1. Click on the frame around the Participants List.

2. Hold the mouse button down while you drag the Participants List to the right side 
of the Conference Room. Release the mouse button. If you have enough room on 
your monitor screen, you can drag the Participants List out of the Conference 
Room. This technique is called drag-and-drop.

3. You can drag-and-drop the Participants List back to its original location at any 
time.

A box around the icon
means that this person is 
currently displayed on your 
screen

Is sending video
Is looking at you 
Is listening to you

This represents you when your video
 image is not displayed on your screen

This represents you when your video
 image is displayed on your screen
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Note that when you move the Participants List, the audio controls and indicators move 

also. When you move them out of the Conference Room, they form a new window 

called the Conference Control Center, as shown in Figure 4-9. 

Figure 4-9. You can drag-and-drop the Participants List and audio controls out of the Conference 
Room window (Windows only)

Resizing the Participants List
You can change the size of the Participants List to make it more narrow or wide.

To resize the Participants List:

1. Move your mouse pointer over the splitter bar between the Participants List and 
the Video windows. The mouse pointer changes to a double arrow.

2. Click and drag the splitter bar to the right or left to change the size of the 
Participants List.
4-18     CU-SeeMe User Guide



Video W
indow

s

Video Windows
Video images of conference participants appear in video window frames in the 

Conference Room. You can display multiple video windows simultaneously.

Seeing Video Images
Some participants in the conference may be sending video images (these people are 

called senders). Some participants may not be sending any video (these people are 

called lurkers). You can choose which senders’ video images you want to see 

displayed on your screen. You can try to display the video image of a lurker, but 

instead of a picture you will get a blank frame with a message telling you that the 

chosen participant has “No Video Stream.”

To see a participant:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images.

2. Point to the name of the participant you want to select, then click.

3. That person’s video image is now displayed in one of the open video window 
frames on your screen.

4. You can repeat this process to see video images of other participants.

You can continue this until all the video window frames are full, or you can stop at any 

time. You do not need to fill all the video windows. In fact, having fewer open video 

windows will increase the performance of your computer during the videoconference.

In addition to the steps described previously, there are other ways you can display the 

video image of a participant. These methods are described next.

Other ways to see a participant:

◆ Double-click on a participant’s name. That person’s video image will appear in 
one of the open video window frames. 

- or - 

◆ Double-click on an empty video frame. The Open Participant dialog box 
appears. Select a participant and click OK.

- or - 
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◆ Click a participant’s name to select it, and then drag it to an open video window 
frame. (This is called drag-and-drop.) That person’s video image will appear in 
the window frame to which you dragged it. This method allows you to place a 
video image in a specific frame. If you drag the participant’s name to a frame that 
already has a video image, the new participant’s image will replace the previous 
image.

- or - 

◆ On the Conference menu, point to Video. This displays a list of conference 
participants who are sending video. Click on a name to display that person’s 
video.

- or - 

◆ (Windows) Using the right mouse button (right-click), select a participant’s 
name. A shortcut menu appears. Click Show Video. That person’s video image 
will appear in one of the open video window frames. 

◆ (Mac OS) Hold down the CONTROL key as you click on a participant’s name 
(CTRL-click). A shortcut menu appears. Click Show Video. That person’s video 
image will appear in one of the open video window frames. 

Closing Video Windows
You may want to close some of the video windows displayed on your screen. You can 

use the same methods that you used to display the video windows.

To close a video window:

1. Click the Video button on the toolbar. This displays a list of all the participants 
who are sending video images. The participants who are currently displayed on 
your screen are indicated by a ✔ in this list.

2. Point to the name of a participant who is displayed on your screen, then click.

3. That person’s video image is no longer displayed in a video window frame on 
your screen.

4. You can repeat this process to close video windows of other participants.

In addition to the steps described previously, there are other ways you can close the 

video image of a participant. These methods are described next.
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Other ways to close a video window:

◆ Double-click on a participant’s name. That person’s video image is no longer 
displayed in a video window frame on your screen.

- or - 

◆ Using the right mouse button (right-click), select a participant’s name in the 
Participants List. A dialog box appears. If that person’s video is currently 
displayed on your screen, you will see a ✔ next to Show Video. Click Show 
Video. That person’s video image is no longer displayed in a video window frame 
on your screen.

- or - 

◆ Using the right mouse button (right-click), select a video window. A dialog box 
appears. Click Hide.

- or -

◆ Double-click on a displayed video window. That person’s video image is no 
longer displayed in a video window frame on your screen.

- or - 

◆ On the Conference menu, point to Video. This displays a list of conference 
participants who are sending video. The participants who are currently displayed 
on your screen are indicated by a ✔. Point to the name of a participant who is 
displayed on your screen, then click. That person’s video image is no longer 
displayed in a video window frame on your screen.

Being Seen
Just as you can choose to see other people in the Participants List, other participants 

can also choose to see you if you are a sender. Remember, if you have a camera 

connected to your computer, you are a sender. However, you can choose to become a 

lurker, which prevents others from seeing your video picture. 

To switch between being a sender and a lurker:

(Windows)

1. Using the right mouse button (right-click), click on your name in the Participants 
List.A shortcut menu appears. If you see a ✔ next to Send Video, then you are a 
sender.
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2. Click Send Video to become a lurker. The ✔ disappears. You have stopped 
sending your video image to other participants

3. If you click Send Video again, you become a sender. You have now turned your 
video on and other participants can choose to see your video picture.

(Mac OS)

1. Make sure that your local video image is displayed in one of the video window 
frames. If it is not currently displayed, see “To see a participant:” on page 2-16 to 
learn how to display your video window.

2. Hold down the CTRL key as you click on your video window (CTRL-click). A 
menu appears. If you see a •  next to Send Video, then you are a sender.

3. Click Send Video to become a lurker. The •  disappears. You have stopped 
sending your video image to other participants

4. If you click Send Video again, you become a sender. You have now turned your 
video on and other participants can choose to see your video picture.
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Changing the Layout of the Video Windows
You can arrange your video window frames to allow different combinations and sizes 

of video windows. 

To change the video layout:

1. Click the Customize button on the Conference Room toolbar. Point to Video 
Layout, then click. The Customize dialog box appears (with the Video Layout tab 
displayed), as shown in Figure 4-10.

Figure 4-10. You can customize the number and layout of video windows on your screen

2. Move the slider to select the maximum number of video windows you want to 
display. 

3. Once you have selected the number of windows, the layout options are displayed 
in the dialog box. 

• (Windows) In some cases, only one layout option is available; in other cases 
multiple layouts are available. Click on a layout to select it.

• (Mac OS) Click <<Previous Layout or Next Layout>> to display different 
layout options. Click OK to select a layout.

To use background color (Windows only):

1. If you want to customize the color that appears in the border around the video 

 

Move the slider to 
select the number of 
video windows you 
want to display.

Once you have selected
the number of windows,
you can click to choose 
the layout from the
options displayed.

Select this check box
to use a custom 
background color
around the video windows.
(Windows only)
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window frames, click to select the option named Use custom background color 
on the Video Layout tab.

2. Click the Color button. The Color dialog box appears. Click to select a color from 
the basic colors table. If you want more color choices, click Other. Chose a color 
from the palette shown. Use the slider to the right of the custom color palette to 
fine-tune the exact color you desire. When you have chosen the color you want, 
click OK. This closes the Color dialog box.

3. Click OK when you are done. The video layout you selected is now shown in the 
Conference Room.

Moving Video Windows 
Once you have a video image displayed on your screen, you can move that image to 

other locations on your screen. You can even drag it out of the Conference Room 

window, where it becomes a separate, floating window!

To move a video window:

1. Click on a video image displayed on your screen.

2. Hold the mouse button down while you drag the video image. Release the mouse 
button when you have dragged the image where you want it to go. For example, 
you can drag the image and drop it on your Chat window, or even outside of your 
Conference Room window. Now you can resize the video image:

• (Windows) Pause your mouse pointer over one of the edges of the video image 
frame, or over a corner of the frame. The pointer turns into a double arrow. 
Click and drag the double arrow to enlarge the video image. You can make the 
image as big as you want. You can shrink the image by dragging the double 
arrow again.

• (Mac OS) Click the size box (the square in the lower, right corner of the video 
image frame) and drag it to enlarge the video image. You can make the image 
as big as you want. You can shrink the image by dragging the size box again.

3. If you want to return the video image to the Conference Room, simply 
drag-and-drop it on the video window frames in the Conference Room window. 
The image will drop into the Conference Room and will automatically resize itself 
to fit the open frame.

You can also drag-and-drop a name from the Participants List to any other location on 

your screen to display that participant’s video image. 
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Resizing the Video Window display area
You can change the size of the Video Window display area to make it larger or smaller. 

The video images will automatically adjust to fit the new size.

To resize the video window display area:

1. Move your mouse pointer over the splitter bar between the Participants List and 
the Video windows. The mouse pointer changes to a double arrow.

2. Click and drag the splitter bar to the right or left to make the video images wider 
or narrower.

3. Now, move your mouse pointer over the splitter bar between the Chat window and 
the Video windows. The mouse pointer changes to a double arrow.

4. Click and drag the splitter bar up or down to make the video images taller or 
shorter.
Chapter 4. Using the Conference Room          4-25



C
ha

t W
in

do
w

Chat Window
You can use Chat to exchange typed messages with other participants. This is 

especially helpful if either you or other users don’t have cameras or microphones, or if 

your bandwidth connection is too limited to carry audio.

The Chat window is located in the lower right portion of the Conference Room 

window and is divided into two sections (or panes), separated by a row of toolbar 

buttons and macro buttons, as shown in Figure 4-11.

Figure 4-11. The Chat window contains two panes, toolbar buttons, and macro buttons

To type Chat text:

1. Type a message in the lower pane of the Chat window. This is the input pane.

2. Press ENTER. Your message now appears in the upper pane of the Chat window. 
This is the display pane where the chat dialog appears.

Other users will see your message and you will see the messages they are typing. You 

can follow Chat conversations in the upper pane of the window. Messages appear in 

the order they are received.

Customizing Chat Style
You can modify the way text appears in the Chat window.

To customize Chat style:

(Windows)

1. Click the Customize button on the Conference Room toolbar. Point to Chat 
Style, then click. The Customize window appears (with the Chat Style tab 

Click to erase all 
Chat text in the 
upper (display) pane

Click to filter selected
Chat text Click to save Chat

text as a file
Click to print 
Chat text

Chat dialog
displays here

Type your 
message here
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displayed), as shown in Figure 4-12.

Figure 4-12. (Windows) You can customize the appearance of Chat text

2. Select a category of text that you want to customize, such as all Chat Text, 
Participant Name, or URL.

3. Select a font type, size, and color. Select bold, italic or underlined text.

4. Select Enable URL Highlighting to display URLs in a different font. (A URL, 
or Uniform Resource Locator, is an address used to locate information on the 
Internet. An example of a URL is http://www.wpine.com.) Select Enable URL 
Launching to turn URL’s in the Chat window into active links that launch a Web 
browser and connect you to that URL.

5. Select Enable Keyword Highlighting to assign specific words in the Chat 
window to appear in a different font or color. For example, if you want the words 
White Pine to appear in the color red in bold, 12 point size whenever it appears in 
a Chat discussion, follow these steps:

• Click to select Enable Keyword Highlighting.

• Click Add. The Add/Edit Text dialog box appears.

• Change the font size to 12.

• Change the color to red.

• Click the bold button.
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• In the text box, type White Pine.

• Click OK.

6. Click OK when you have completed customizing the Chat style.

To customize Chat style:

(Mac OS)

1. Click the Customize button on the Conference Room toolbar. Point to Chat 
Style, then click. The Customize window appears (with the Chat Style tab 
displayed), as shown in Figure 4-13.

Figure 4-13. (Mac OS) You can customize the appearance of Chat text

2. Select a category of text that you want to customize, such as Chat Text, Participant 
Name, Keywords or URL.

(A URL, or Uniform Resource Locator, is an address used to locate information 
on the Internet. An example of a URL is http://www.wpine.com. You can 
highlight a URL, which can be turned into an active link on the Chat window that 
launches a Web browser and connects to that URL.)

3. Select a font type, size, and color. Select bold, italic or underlined text.

4. Click OK when you have completed customizing the Chat style.

5. Use Keyword Highlighting to assign specific words in the Chat window to 
appear in a different font or color. For example, if you want the words White Pine 
to appear in the color red, in bold, 12 point size whenever it appears in a Chat 
discussion, follow these steps:

• Click Add in the Keyword Highlighting section of the tab. The Add/Edit Text 
dialog box appears.
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• Type White Pine and click OK.

• In the Chat Style section of the tab, select the category Keywords style.

• Change the font size to 12.

• Change the color to red.

• Click the bold button.

• Click OK.

Using Chat Macros
A macro is a series of simple commands that allow you to automate tasks. You can use 

macros in the Chat window to eliminate typing of words, phrases, or symbols that you 

use often. Macros can be used for such things as your e-mail address, your favorite 

phrase, or even a smiley face.

To create Chat macros:

1. Click the Customize button on the Conference Room toolbar. Point to Chat 
Extensions, then click. The Customize window appears (with the Chat 
Extensions tab displayed), as shown in Figure 4-14.

Figure 4-14. You can assign Chat macros and filters 
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2. Select Enable Chat macros (Windows only).

3. Click Add to create a new macro.

4. Type the text that you want the macro button to represent.

5. Select an icon from the list provided.

6. Click OK.

The selected icon will now appear in the toolbar in the Chat window. When you are 

typing Chat, you can click that macro button to insert the desired word or phrase. Note 

that when you create the macro, you can choose to press ENTER at the end of the 

macro text. This will cause the macro text to automatically appear in the upper Chat 

window pane when you click the macro button. If you do not press ENTER when 

composing your Chat macro text, your text will appear in the lower Chat window pane 

and you will need to press ENTER to send it.

Filtering Chat Text
There are times when you may not want your Chat window to show the messages of 

all the conference participants. Fortunately, CU-SeeMe allows you filter out unwanted 

text from your Chat window. Chat filters prevent you from seeing undesired Chat text 

sent by others, but they do not prevent the Chat text that you send from being seen by 

other participants. To send Chat to one selected participant only, see “Having a Private 

Chat” on page 4-31.

To filter Chat text:

1. Click the Customize button on the Conference Room toolbar. Point to Chat 
Extensions, then click. The Customize dialog box appears (with the Chat 
Extensions tab displayed), as shown in Figure 4-14. 

(You can also open this dialog box by clicking the filter button  on the toolbar 
in the Chat window.)

2. The Filter Participants section of the dialog box shows a list of all participants in 
the current conference. Click on a name in that list. Then click Exclude.

• (Windows) The name is now moved to the Exclude List. 

• (Mac OS) That participant’s check box is now cleared.
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This means that Chat text from the selected person will not appear in your Chat 

window. You have excluded this person, or filtered this person from your Chat 

window.

3. You can repeat this process with other names to filter out more participants.

4. (Windows) Click on a name in the Exclude List. Then click Include. The name 
is now moved back to the Include List. Chat text from the selected person will 
appear in your Chat window once again.

(Mac OS) Click on the name of a participant who has been excluded from Chat. 

Then click Include. The check box is selected again. Chat text from the selected 

person will appear in your Chat window once again.

5. Using the option at the bottom of the dialog box, you can choose to have new 
participants in the conference either automatically allowed in (Include) or filtered 
from (Exclude) your Chat window. 

6. Click OK when you are done.

Having a Private Chat
You can establish a private Chat with another participant. This means that even in a 

busy conference, you can have your Chat messages go to only one person whom you 

select. Other participants will not see what you type in the Chat window, however you 

will continue to see Chat text from all the other participants.

To establish a private chat:

1. On the Conference menu, point to Chat to. 

2. Point to the name of the person to whom you would like to send private chat. Then 
click.

3. Now, anything you type in the Chat window will be sent only to the selected 
person.

4. To stop sending private chat to that person, go to the Conference menu, point to 
Chat to.

5. Point to the name of the person to whom you have sent private messages. Then 
click.

6. Now, you are returned to public chat mode.
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When you are sending private Chat, you will see an indicator (●) next to your name 

in the Chat window, reminding you that you are sending private Chat. In addition, the 

words Public Chat in the Chat window change to Private Chat to <name>. You can 

send private Chat to only one person at a time. When another participant is sending 

private Chat to you, you will also see an indicator (●) next to that participant’s name 

in the Chat window, letting you know that you are receiving private Chat from that 

person. 

To change to private Chat mode temporarily:

1. In the Chat window type the name of the person to whom you would like to send 
private chat, followed by two angle brackets (>>), for example David>>. 

2. Type your Chat message and press ENTER. That message will be private and will 
be seen only by David and you, even though you are still in public Chat mode. 

Your next message will be public unless you use this procedure again to temporarily 

change to private Chat mode. (If you had been involved in a private Chat with a 

participant before this last private message, you will remain in that mode.)

To send a public message while in private Chat mode:

1. Type two angle brackets (>>) followed by your Chat message. Then press 
ENTER.

2. Your message will be seen by everyone, even though you will still be in private 
Chat mode. Your next Chat message will be in private mode again.

Using Name Completion with Private Chat
This feature is the quickest way to enter the name of a conference participant and send 

that participant a private Chat message.

To complete a participant name automatically:

1. Type the beginning letter or letters of the person’s name as it appears in the 
Participants List. For example, type J for Jonathan.

2. Press the TAB key. The name is completed and the angle brackets (>>) are added 
for you. That means when you type your Chat message and press ENTER, the 
message will be sent only to that person. 
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If there is another person in the conference with the same first letter or letters in their 

name (for example, Jonathan, Johanna, Joe), the system will default to the first name 

on the Participants List. Press TAB multiple times to cycle through names in the 

Participants List that start with the letter (or letters) you typed. In this example, 

pressing TAB will cycle you through the “J” names—Jonathan, Johanna and Joe—as 

long as these names are in the Participants List. 

When you use the name completion feature, private Chat is temporary; you will return 

to public Chat mode immediately after sending your Chat message.

Resizing the Chat Window
You can change the size of the Chat Window display area to make it larger or smaller. 

The video images will automatically adjust to fit the new size.

To resize the Chat window:

1. Move your mouse pointer over the splitter bar between the Participants List (or 
Audio Controls) and the Chat window. The mouse pointer changes to a double 
arrow.

2. Click and drag the splitter bar to the right or left to make the Chat window wider 
or narrower.

3. Now, move your mouse pointer over the splitter bar between the Chat window and 
the Video windows. The mouse pointer changes to a double arrow.

4. Click and drag the splitter bar up or down to make the Chat window taller or 
shorter.
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Audio Modes
Your Windows computer must have a sound card installed if you want to send and 

receive audio. If you have a full-duplex sound card, you can send and receive audio 

simultaneously. All computers running Mac OS have full-duplex audio capabilities 

built in. This is similar to a telephone which allows you to talk and hear at the same 

time. If you have a half-duplex sound card in your Windows computer, you send and 

receive audio, but you cannot do both at the same time. This is similar to a 

walkie-talkie with which each person must take turns speaking. 

With CU-SeeMe, you can transmit audio in your choice of two modes:

◆ Hands Free

You transmit audio continuously. Everything you say is transmitted. If you have 
a full-duplex sound card, CU-SeeMe selects Hands Free as your default audio 
mode.

◆ Push To Talk

You only transmit audio when you push a button. If you have a half-duplex sound 
card, CU-SeeMe selects Push To Talk as your default audio mode.

You can switch between Hands Free and Push To Talk modes while you are connected 

to a conference. 

To switch between Hands Free and Push To Talk modes:

1. Click the Customize button on the Conference Room toolbar. Point to 
Configuration, then click. The Customize dialog box appears (with the 
Configuration tab displayed), as shown in Figure 4-15.
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Figure 4-15. You can switch between Hands Free and Push To Talk modes

2. The upper portion of this dialog box is for audio settings. If the Hands Free 
Operation check box is selected, CU-SeeMe is in Hands Free mode. If this check 
box is not selected, CU-SeeMe is in Push To Talk mode. Click this check box to 
switch between these modes.

3. If you select Hands Free Operation, you can select additional check box options 
(Use Echo Reduction and High Mode). If you select Push To Talk, you can select 
only the High Mode option. (Note that CU-SeeMe for Mac OS does not have the 
High Mode option.)

• Use Echo Reduction

This is used to eliminate feedback which can occur if your microphone is 
located near your speakers. Select this check box to eliminate feedback if it is 
a problem.

• High Mode (Windows only)

For most users, this check box should not be selected. Selecting High Mode 
results in a larger amount of redundant audio data transmitted. This may be 
useful if you have noisy network lines, however it sends more data and 
therefore uses more bandwidth.

4. Click OK when you are done.
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To learn about audio codecs, see “Choosing an Audio Codec” on page 5-7.

Audio Controls and Indicators
The audio controls and indicators consist of buttons, level indicators, and sliders, as 

shown in Figure 4-16.

Figure 4-16. Audio controls and indicators are grouped together in the Conference Room

Turning Your Speakers Off and On
To turn your speaker off, click the speaker button. A red slash appears on the button, 

indicating that this control is turned off. Click it again to turn it on.

Using Your Microphone in Hands Free Mode
If you are in Hands Free mode, click the Microphone button to turn it on or off. Note 

that if you have a half-duplex sound card, and you select Hands Free mode and turn 

your microphone on, your speaker will be turned off. This is because with a 

half-duplex sound card, your microphone and speaker cannot be turned on at the same 

time. You will need to turn your microphone off in order to receive audio, or switch to 

Push To Talk mode. 

Using Your Microphone in Push To Talk Mode
If you are in Push To Talk mode, you must click and hold the microphone button in 

order to transmit audio. This is the recommended mode if you have a half-duplex 

sound card. To learn more about Hands Free and Push To Talk modes, see “Audio 

Modes” on page 4-34.

Squelch Echo reduction

Your microphone

Your speaker

Microphone volume level

Speaker volume level

on/off switch

on/off switch
4-36     CU-SeeMe User Guide



A
udio C

ontrols and Indicators
Adjusting Audio Levels
Use the volume sliders (shown in Figure 4-16) to raise and lower the level of sound 

being sent from your microphone and being played through your speakers. Move the 

sliders to the right to increase the levels and to the left to decrease the levels. The level 

indicators show the level of sound being sent or received.

If you are in Hands Free mode, you will see a red triangle above the microphone level 

indicator (see Figure 4-16). This is the Squelch control and it is only displayed when 

you are in Hands Free mode. This control sets the minimum level for sound to be sent 

from your microphone when you are not receiving audio. Any sound below this level 

will not be transmitted. Drag the Squelch control to the right to raise the minimum 

level of sound that you will transmit. This can be useful when there is background 

noise in your environment. You can adjust the squelch level so that the background 

noise is not transmitted. 

If you are in Hands Free mode and you have Echo Reduction turned on, you will also 

see a green triangle above the microphone level indicator (see Figure 4-16). This is the 

Echo Reduction control. Echo Reduction is similar to Squelch control, except that it 

works when you are receiving audio. When you are receiving audio and sending audio 

simultaneously, the Echo Reduction control can prevent your microphone from 

sending sound that is coming from your speakers. Dragging the Echo Reduction 

control to the right will raise the minimum level of sound that you will transmit. Echo 

Reduction will also eliminate feedback, which can occur if your microphone is placed 

near your speakers. 

When you are sending audio above the minimum level, then your audio is actually 

being sent on the network and others can hear you. (Windows only: When your audio 

is being transmitted, you will see an animated sound wave appear next to the 

microphone level indicator, as shown in Figure 4-16.)

Sending audio and video simultaneously takes a large amount of bandwidth. If you are 

using a low bandwidth connection, such as a modem, you can freeze your local video 

window to increase the amount of bandwidth available for sending audio. 
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Status Bar
The Status Bar, located at the bottom of the Conference Room window, provides tips 

and information about your current status. For example, when you click and hold on a 

toolbar button (Windows), or pause over a toolbar button (Mac OS), the Status Bar 

presents information about that button. When you pause your mouse pointer on a menu 

command, the Status Bar presents information about that command. In addition, the 

Status Bar tells you how long you have been connected to the current conference.
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Getting Information About a Participant
You can get information about a participant in a conference. One way is to get a 

participant’s Contact Card, which provides you with contact information about that 

person. To learn how to do this, see “Exchanging Contact Cards” on page 4-41. You 

can also get information about a participant’s software version, codecs, network 

connection, and more in a separate floating window, called the Info window.

To display the Info window:

1. Do one of the following:

• (Windows) Using the right mouse button (right-click), select a video window 
or a name in the Participants list. 

• (Mac OS) Hold the CONTROL key and click on a video window or a name in 
the Participants list (CTRL-click). 

2. A shortcut menu appears. Click Info.

3. The Info window is displayed, as shown in Figure 4-17. Click on any of the four 
tabs in the Info window to see the following information about the selected 
participant:

• The version of CU-SeeMe (or other H.323 videoconferencing client software)

• The audio and video codecs 

• Whether the participant is sending video, looking at you, hearing you, and can 
send audio

• Sending and receiving limits allowed by the conference or network connection; 
the actual send and receive data of the participant; the actual amount of data 
you are receiving from the participant; the frame rate you are receiving; and the 
packet loss percentage.
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Figure 4-17. You can get information about a participant’s software and network

4. Click on another video window or name in the Participants List. The Info window 
changes to display information about the new participant that you selected. 

5. Click the close button to close the Info window.

IP address of the 
selected participant

Version of CU-SeeMe 
the participant is using

The video and audio
codecs the participant
is using

Displays whether 
the participant:
- is sending video
- is looking at you
- is hearing you
- can send audio

Amounts of data you are
actually receiving;
packet loss percentage

Amount of data the 
participant is actually sending

Maximum send and receive
limits set by the participant

Minimum send and 
receive limits set 

Amount of data the
participant is actually

by the participant

receiving
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Exchanging Contact Cards
A Contact Card is like a business card or a card in a rotary file. It is a convenient way 

to present and store information about a person or place, including contact 

information. Some users of CU-SeeMe have created Contact Cards about themselves. 

You can get Contact Cards from these people electronically and add these cards to 

your Phone Book. This will enable you to store contact information about these people 

and call them directly from your Phone Book. 

When you created a Personal Profile, you also created a Profile Contact Card. Just as 

you can get the Contact Cards of other users, they can get your Contact Card. If you 

choose to videoconference on public conferences, your Profile Contact Card can be 

seen and saved by anyone with CU-SeeMe; therefore, you should be careful what 

information you choose to display on your Profile Contact Card. For example, if you 

do not want strangers to have your phone number, then you should not list it on your 

Contact Card. 

To get a contact card from a participant:

1. On the Conference menu, point to Get Contact Card of. This displays a list of 
all the participants who have Contact Cards.

2. Point to the name of the participant you want to select, then click.

3. The Contact Card of the selected participant is now displayed in a separate 
window, as shown in Figure 4-18.

Figure 4-18. You can get a Contact Card from another CU-SeeMe user
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4. If you want to save the card, click Save. This will save the Contact Card in your 
Phone Book. You can change the Nickname for the card (as it will appear in your 
Contact Card list) and you can assign it to a Contact Group. For more information 
see “Contact Groups” on page 3-13.

5. Click OK. 

To find out how to create your own Contact Card that can be shared with others see 

“Creating a Personal Profile” on page 3-25.
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Disconnecting From a Conference
When you are ready to leave a conference, you can disconnect from the conference in 

one of 2 ways.

To disconnect from a conference:

◆ On the Conference menu, click Hang Up.

- or -

◆ Click the Hang Up button on the toolbar.

This will disconnect you from the current conference. The Conference Room window 

will close automatically and the Phone Book window will appear. You can exit the 

application or use the Phone Book to connect to other conferences. To learn more 

about using the Phone Book, see Chapter 3.

To exit the application: 

Do one of the following:

• (Windows) Choose Exit from the File menu in the Phone Book.

• (Mac OS) Choose Quit from the File menu. 
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Chapter 5

Configuring Your System

You can use CU-SeeMe on any IP-based network or connection and on many types 

of computers. The performance of your system will depend on many factors, 

including the type of communication channel you are using (such as a modem, an 

ISDN line, an Ethernet connection, and so on), the processing speed of your 

computer, and the number of video windows simultaneously displayed on your 

screen.

There are steps you can take to configure and customize your CU-SeeMe software 

to get the best possible videoconference experience. Some of these steps are 

explained in this chapter. Other information is available in online Help and in the 

Frequently Asked Questions (FAQs) on the CU-SeeMe Web pages at 

http://support.wpine.com/cuseeme.
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Choosing a Video Codec
CU-SeeMe uses special codec (COmpressor/DECcompressor) software to compress 

and decompress your video (or audio) data so that it can be sent more efficiently across 

a network. You can choose a video codec to best work with your network connection 

and the type of computer you are using.

CU-SeeMe lets you choose from 3 video codecs:

◆ White Pine M-JPEG

The Motion JPEG (or M-JPEG) codec offers high quality video on local area 
networks (LANs) and ISDN (or higher) network connections. It will also work 
with modems, however lower quality settings (15% to 25%) are recommended. It 
works with 8-bit, 16-bit, and 24-bit input (sometimes referred to as high color or 
true color).

◆ White Pine H.263

This is a good codec for general use on local and wide area networks (LANs and 
WANs), however it uses more CPU power than the other codecs. This codec is not 
recommended for modem users as it will likely result in slow performance. White 
Pine H.263 is a standards-based codec. Video sent with this codec can be seen by 
users of CU-SeeMe Version 3.0 and higher. It can also be seen by users of other 
videoconferencing software that meets the H.323 standard (such as Microsoft 
NetMeeting or Intel Internet Video Phone) when you are connected to a group 
conference hosted on a MeetingPoint Conference Server.

(Note: Macintosh computers with 68000 series processors cannot send or receive 

video using the White Pine H.263 video codec.)

◆ Cornell CU-SeeMe Gray

This codec only sends grayscale images. The other video codecs let you send color 
images (if you are using a color camera). It is an excellent codec for modem users, 
as well as users on LANs and WANs. You should choose this codec if your 
camera or capture device does not support color.

Note: The White Pine Color codec, included in earlier versions of CU-SeeMe, has 

been replaced with newer codecs that support standards-based conferencing. As a 

result, you will not be able to see other users who are sending video using the White 

Pine Color codec. However, if you had an earlier version of CU-SeeMe installed on 

your computer, then you may still have the White Pine Color codec installed. This will 

enable you to see others who are sending with this codec.
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Previous versions of CU-SeeMe did not include all of these video codecs. People using 

earlier versions of CU-SeeMe software will not be able to receive video sent with some 

of the newer codecs. Table 5-1 explains who can see your video image, depending on 

your choice of video codec.

The best way to adjust a video codec is using the Test Setup feature in the Phone Book. 

This allows you to see your local and remote video images simultaneously so you can 

observe the effects of the changes you make. See “Test Your Setup” on page 5-12 for 

more information. You can also change video codec settings from the Conference 

Room while in a videoconference.

Table 5-1. Determining who can see your video image

If you are using this 
codec

These users will be able to see your video 
image

White Pine M-JPEG Any user with CU-SeeMe V3.0 or later or 
Enhanced CU-SeeMe V2.1.1. 

White Pine H.263 Any user with CU-SeeMe V3.0 or later (except 
users with Macintosh computers with 68000 
series processors).

Cornell CU-SeeMe Gray Any user with any version of CU-SeeMe 
(including Cornell freeware).
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To choose a video codec:

1. Click the Customize button on the Conference Room toolbar. Point to 
Configuration, then click. The Customize dialog box appears (with the 
Configuration tab displayed), as shown in Figure 5-1.

Figure 5-1. You can select a video codec to best fit your hardware and network setup

2. The video codec section is presented in the lower portion of the dialog box. Click 
the arrow next to the video codec to display a list of available codecs. Click on the 
name of the desired codec.

3. Click Configure. Some codecs allow you to make additional configuration 
settings and other codecs do not. For example, you cannot change configuration 
settings for White Pine M-JPEG and White Pine H.263 codecs.

4. You can use the video codec Quality slider to adjust the clarity of the video image 
you send. (It does not affect the video you see displayed on your screen.) The 
Quality slider is preset for each codec, but you can adjust it manually. While 
increasing the Quality setting will improve the clarity of the picture you send, it 
will also use more bandwitdth, which causes a longer time delay in your video 
picture. Lowering the Quality setting will send a faster but lower quality video 
image. This will work better with a lower bandwidth network connection, such as 
a modem. See also “Test Your Setup” on page 5-12.

5. Click OK when done.
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When Video Codecs Are Required by a Conference
When a MeetingPoint Conference Server is hosting a conference, it can require that 

participants use specific video and/or audio codecs to join the conference. When you 

try to join such a conference, CU-SeeMe will attempt to change its codecs 

automatically to match the conference requirements. If the required video codec 

cannot be found, you will join the conference as a lurker (if the conference allows 

lurkers). If the required audio codec cannot be found, you will not be able to send audio 

for the duration of the conference.

When you leave the conference, you will need to switch back to your previous video 

and audio codecs manually.

Recommended Settings for Each Video Codec
The best settings for each codec depend on a number of factors including your network 

connection. While there is no ideal setting for all conditions, recommendations are 

described below. They are intended as a starting point, however you may find that you 

need to adjust your settings from the recommended values.

Configuration refers to the Configure button shown in Figure 5-1. Quality refers to the 

slider, also shown in Figure 5-1, and described on page 5-4.

Settings for White Pine M-JPEG

Configuration

There is nothing to configure for this codec.

Quality

For a LAN or WAN, the recommended quality setting is between 25 and 65%. The 

settings are dependent on available bandwidth, your network connection, and the 

processing speed of your computer’s CPU. For a modem, the recommended setting is 

between 15 and 25%. See page 5-3 to learn how to adjust Quality.

Settings for White Pine H.263

Use this codec with 24-bit capture for best quality. This codec is not compatible with 

all video capture cards. Macintosh computers with 68000 series processors cannot 

send or receive White Pine H.263 video. If you have difficulty using this codec, switch 

to White Pine M-JPEG.
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Configuration

There is nothing to configure for this codec.

Quality

For a LAN or WAN, the recommended quality setting is between 20 and 40%. This 

codec is not recommended for modem users as it will result in slow performance. See 

page 5-4 to learn how to adjust Quality.

Settings for Cornell CU-SeeMe Gray

Configuration

There is nothing to configure for this codec.

Quality

For a LAN or WAN, the recommended quality setting is between 35 and 55%. For a 

modem, the recommended setting is between 20 and 35%. See page 5-3 to learn how 

to adjust Quality. 
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Choosing an Audio Codec
CU-SeeMe uses codec software to efficiently send video and audio data across a 

network, as explained in “Choosing a Video Codec” on page 5-2. Your choice of codec 

will depend on your computer environment, especially whether you are 

communicating using a modem, a LAN, or an ISDN line. Use Table 5-2 to choose the 

best audio codec for your computer.

Table 5-2. Audio codec recommendations

You can use this 
audio codec

If you are using this means of 
communication

Modem ISDN LAN

G.723.1 elemedia™
(5.3 Kbps)

✔ ✔ ✔

G.723.1 elemedia™ 
(6.4 Kbps)

✔ ✔ ✔

DigiTalk (8.5 Kbps) ✔ ✔ ✔

Delta-Mod (16 Kbps) ✔ ✔

Intel® DVI (32 Kbps) ✔ ✔
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As with the video codecs, previous versions of CU-SeeMe did not include all of these 

audio codecs. People using older versions of the software will not be able to receive 

audio sent with some of the newer codecs. Table 5-3 explains who can hear your audio, 

depending on your choice of audio codec.

The DigiTalk and G.723.1 audio codecs all work well with low bandwidths and 

therefore are usable with most modems. While all of the audio codecs are designed 

primarily for speech, the DigiTalk and G.723.1 (6.4 Kbps) codecs are able to transmit 

both voice and music over modems, whereas the Voxware codec is able to send voice 

only. Because of its lower bit rate, the G.723.1 codec is more appropriate for modem 

users than the DigiTalk codec, and delivers better audio quality. Although the 

Delta-Mod and Intel® DVI codecs can both be heard by any CU-SeeMe user, they 

require large amounts of bandwidth (Intel® DVI requires the most bandwidth), and 

therefore may slow the overall performance of CU-SeeMe.

Sending audio and video simultaneously takes a large amount of bandwidth. If you are 

using a low bandwidth connection, such as a modem, you can freeze your local video 

window to increase the amount of bandwidth available for sending audio. 

To freeze your local video:

(Windows)

1. Right-click on your local video window. A shortcut menu appears.

Table 5-3. Determining who can hear your audio

If you are using this 
codec

These users will be able to hear your 
audio

G.723.1 elemedia
(5.3 Kbps)

Any user with CU-SeeMe V3.1 (except users with 
Macintosh 68000 series processors) 

G.723.1 elemedia
(6.4 Kbps)

Any user with CU-SeeMe V3.1 (except users with 
Macintosh 68000 series processors) 

DigiTalk (8.5 Kbps) Any user with CU-SeeMe V3.0 or later (Windows 
and Mac OS), and Enhanced CU-SeeMe V2.0 or 
later (Windows users only)

Delta-Mod (16 Kbps) Any user with any version of CU-SeeMe 
(including Cornell freeware) and Enhanced 
CU-SeeMe

Intel® DVI (32 Kbps) Any user with any version of CU-SeeMe 
(including Cornell freeware) and Enhanced 
CU-SeeMe
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2. Click Freeze Video. A ✓ appears, indicating that your video is frozen. 

3. Click it again when you want to return to sending full-motion video.

(Mac OS)

1. Hold down the CONTROL key and click on your local video window 
(CTRL-click). A shortcut menu appears.

2. Click Freeze Video. A •  appears, indicating that your video is frozen. 

3. Click it again when you want to return to sending full-motion video.

When Audio Codecs Are Required by a Conference
When a MeetingPoint Conference Server is hosting a conference, it can require that 

participants use specific video and/or audio codecs to join the conference. When you 

try to join such a conference, CU-SeeMe will attempt to change its codecs 

automatically to match the conference requirements. If the required video codec 

cannot be found, you will join the conference as a lurker (if the conference allows 

lurkers). If the required audio codec cannot be found, you will not be able to send audio 

for the duration of the conference.

When you leave the conference, you will need to switch back to your previous video 

and audio codecs manually.
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To choose an audio codec:

1. Click the Customize button on the Conference Room toolbar. Point to 
Configuration, then click. The Customize dialog box appears (with the 
Configuration tab displayed), as shown in Figure 5-2.

Figure 5-2. You can select an audio codec

2. The audio codec section is presented in the upper portion of the dialog box. Move 
the audio codec slider to select an audio codec. Note that moving the slider to the 
right improves the quality of the audio you send, but it also decreases performance 
of your computer. Moving the slider to the left increases performance but lowers 
the quality. A lower quality audio codec will work better with a lower bandwidth 
network connection, such as a modem. See “Choosing an Audio Codec” on page 
5-7 for information to help you select an audio codec. 

3. Select the Hands Free Operation check box if you have a full-duplex sound card. 
If you select Hands Free, you will also see a check box labeled Use Echo 
Reduction. When you are receiving audio and sending audio simultaneously, the 
echo reduction control can prevent your microphone from sending sound that is 
coming from your speakers. This will eliminate feedback, which can occur if your 
microphone is placed near your speakers. Select this check box to use echo 
reduction. When echo reduction is selected, (and you have clicked OK or Apply), 
you will see red and green triangle sliders above the microphone indicator in the 
audio control section of the Conference Room Window. To learn how to use these 
sliders and to learn more about Hands Free mode, see “Using Your Microphone 
in Hands Free Mode” on page 4-36.
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4. Select the High Mode check box (Windows only) if you are sending audio over a 
high loss network. High mode adds more redundant audio data across the network 
which helps your audio to be clearer even if some data is lost. High mode also 
causes your audio to be delayed several seconds.

5. Click OK when done.
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Test Your Setup
The best way to adjust your video and audio settings is using the Test Setup feature. 

To use this, click the Test Setup button on the Phone Book toolbar. The Test Setup 

dialog box appears, as shown in Figure 5-3.

Figure 5-3. Test Setup dialog box allows you to easily configure your video and audio

The Test Setup dialog box has two tabs, one for testing video and the other for testing 

audio. 

This is your local
video image

This is your remote video,
as others will see you
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Testing Video
The Test Video tab is shown in Figure 5-3. If you have a video camera and it is 

connected and configured correctly, you will see two video images of yourself. The 

one on the left is your local video and the one on the right is your remote video image. 

The remote video image shows how others will see you in a conference. The remote 

video image is helpful because you can change codec settings and see how it affects 

the video that you send. 

To change video codec settings:

1. Click the arrow next to the video codec to display a list of available codecs. Click 
on the name of the desired codec.

2. Click Configure. Some codecs allow you to make additional configuration 
settings and other codecs do not. For example, you cannot change configuration 
settings for White Pine M-JPEG and White Pine H.263 codecs.

3. The compression adjustment slider is preset for each codec; however, you can 
adjust it manually. Note that moving the slider to the right improves the quality of 
the image you send, but it also decreases performance of your computer. Moving 
the slider to the left increases performance but lowers the quality. Lowering the 
quality setting sends a lower quality video image and sends less data. Therefore, 
a lower quality setting will work better with a lower bandwidth network 
connection, such as a modem.

Higher quality settings use more bandwidth and cause a longer time delay in your 
video picture.You can observe this by setting your quality to a high setting, 
viewing both your local video and remote video simultaneously, and then waving 
your hand in front of the video camera. The higher the quality setting, the more 
time delay there is between when you move your hand and when the movement 
is shown in the remote video window. You will see that the quality setting does 
not affect your local video window. Choose the lowest quality setting that 
provides an acceptable remote video image. If you are using a modem, you will 
need to use a lower quality setting than if you are using LAN or WAN.

4. Click the arrow next to the capture device to display a list of video capture devices 
installed in your computer. Click on the name of the desired device.

5. Do one of the following:

• (Windows) Click Format or Source to make additional settings adjustments.

• (Mac OS) Click Configure to make additional settings adjustments.

6. Click OK when done.
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Testing Audio
If you have a microphone, speaker, and sound card, you can test and adjust your audio 

settings using the Test Setup feature.

To change audio settings:

(Windows)

1. Click the Test Setup button on the Phone Book toolbar. The Test Setup dialog 
box appears. Click on the Test Audio tab. The Test Audio tab is shown in Figure 
5-4.

Figure 5-4. (Windows) Test your audio setup

2. Move the audio codec slider to select an audio codec. Note that moving the slider 
to the right improves the quality of the audio you send, but it also decreases 
performance of your computer. Moving the slider to the left increases 
performance but lowers the quality. A lower quality audio codec will work better 
with a lower bandwidth network connection, such as a modem. See “Choosing an 
Audio Codec” on page 5-7 for information to help you select an audio codec. 

Audio codec slider

Select this if you have
a full duplex sound card
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3. Select the Hands Free check box if you have a full-duplex sound card. (To learn 
more about Hands Free mode, see “Using Your Microphone in Hands Free Mode” 
on page 4-36.) If you are in Hands Free mode, you will see the Squelch slider. The 
Squelch control is only displayed when you are in Hands Free mode. This control 
sets the minimum level for sound to be sent from your microphone when you are 
not receiving audio. Any sound below this level will not be transmitted. Drag the 
Squelch slider to the right to raise the minimum level of sound that you will 
transmit. This can be useful when there is background noise in your environment. 
You can adjust the squelch level so that the background noise is not transmitted. 

4. Speak into your microphone to test the volume level. Move the microphone 
volume slider to raise or lower the level.

5. Click the arrow next to Recording Device to display a list of audio recording 
devices installed in your computer. Click on the name of the desired device.

6. Click Test to play a sound sample. Move the speaker volume slider to raise or 
lower the sound level.

7. Click the arrow next to Playback Device to display a list of audio playback 
devices installed in your computer. Click on the name of the desired device.

8. Click OK when done.

To change audio settings:

(Mac OS)

1. Click the Test Setup button on the Phone Book toolbar. The Test Setup dialog 
box appears. Click on the Test Audio tab. The Test Audio tab is shown in Figure 
5-5.

Figure 5-5. (Mac OS) Test your audio setup

Audio codec slider
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2. Move the audio codec slider to select an audio codec. Note that moving the slider 
to the right improves the quality of the audio you send, but it also decreases 
performance of your computer. Moving the slider to the left increases 
performance but lowers the quality. A lower quality audio codec will work better 
with a lower bandwidth network connection, such as a modem. See “Choosing an 
Audio Codec” on page 5-7 for information to help you select an audio codec. 

3. Select the Hands Free check box to see the Squelch slider. (To learn more about 
Hands Free mode, see “Using Your Microphone in Hands Free Mode” on page 
4-36.) The Squelch control is only displayed when you are in Hands Free mode. 
This control sets the minimum level for sound to be sent from your microphone 
when you are not receiving audio. Any sound below this level will not be 
transmitted. Drag the Squelch slider to the right to raise the minimum level of 
sound that you will transmit. This can be useful when there is background noise 
in your environment. You can adjust the squelch level so that the background 
noise is not transmitted. 

4. Speak into your microphone to test the volume level. Move the microphone 
volume slider to raise or lower the level.

5. Click the arrow next to Recording Device to display a list of audio recording 
devices installed in your computer. Click on the name of the desired device.

6. Click the arrow next to Source to display a list of audio sources. Click on the 
name of the desired device.

7. Click Test to play a sound sample. Move the speaker volume slider to raise or 
lower the sound level.

8. Click the arrow next to Playback Device to display a list of audio playback 
devices installed in your computer. Click on the name of the desired device.

9. Click OK when done.
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Setting Transmission and Reception Rates
For best performance you may need to adjust the rate at which you send and receive 

video and audio signals. Table 5-4 shows CU-SeeMe’s default minimum and 

maximum transmission and reception rates for a range of networking devices.

You can increase transmission rates for better performance, however, there are limits. 

For example, if you are transmitting with a 28.8 Kbps modem, you will be limited to 

a maximum transmission rate of 28 Kbps.

The reception options set the rate at which you receive audio and video. Limiting 

reception may be important if you have a 28.8 Kbps modem connection. If you are set 

to receive 30 Kbps for example, you may not be able to send any signals out because 

you will be using all of your available bandwidth to receive signals.

When you join a group conference, you may find that some conferences will not admit 

you until you make adjustments in your transmission and receptions rates. Other 

conferences may ask you if you would like to have your rates adjusted automatically. 

You can choose this automatic adjustment option if it is presented to you.

Table 5-4. Default transmission and reception rates

When using 
Minimum 

Send
(Kbps)

Maximum 
Send

(Kbps)

Minimum 
Receive
(Kbps)

Maximum 
Receive
(Kbps)

Modem 28.8 Kbps 1 18 1 18

Modem 33.6 Kbps 1 20 1 20

Modem 56 Kbps 5 20 5 35

ISDN 64 Kbps 5 40 5 40

ISDN 128 Kbps 10 80 10 80

LAN 256 Kbps 10 80 10 150

LAN T1 and more 10 80 10 300
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Setting Rates for a Contact Card
You can set minimum and maximum transmission and reception rates for each entry 

in your Phone Book using the Contact Card Editor. This is useful because some 

conference servers require lower transmission rates than others and you can preset 

your rates for each conference server individually by editing the Contact Card in the 

Phone Book.

To set transmission and reception rates using the Contact Card Editor:

1. Select the entry in the Contact Card list by clicking on a Contact Card or a name 
in the list of Contact Cards.

2. On the Edit menu, click Contact Card Properties. The Contact Card Editor 
appears. Select the Network tab as shown in Figure 5-6.

Figure 5-6. The Contact Card Editor lets you modify transmission and reception rates

3. Change the maximum transmission and reception rates by clicking on the arrows 
or typing a new rate in the text boxes (see Figure 5-6). 

4. Change the minimum transmission and reception rates by typing in the text boxes 
(see Figure 5-6).

Select this to 
modify settings

Enter maximum
transmission rate
(Kbps)

Enter maximum
reception rate
(Kbps)

Select this to send
video when connected

Select this to use the
settings defined in your
Personal Profile

Enter minimum
reception rate
(Kbps)

Enter minimum 
transmission rate
(Kbps)

Select this to use the
minimum reception
and transmission rates
you define
5-18     CU-SeeMe User Guide



Setting Transm
ission and R

eception R
ates
5. When you have completed all your edits to the Contact Card, click OK. These 
changes will be saved in your Contact Card. Any time you connect to the person 
or place on that Contact Card, you will use these new settings.

Setting Rates While In a Conference
In addition to setting rates for each Contact Card, you can also change your maximum 

transmission and reception rates while you are in a conference. This change will affect 

the current connection only.

To set transmission and reception rates in a conference:

(Windows)

1. Click the Customize button on the Conference Room toolbar. Point to 
Hardware, then click. The Customize dialog box appears (with the Hardware tab 
displayed), as shown in Figure 5-7.

Figure 5-7. (Windows) You can change transmission and reception rates while in a conference

Select this to 
modify settings

Enter maximum
transmission rate
(Kbps)

Enter maximum
reception rate
(Kbps)

Select this to use the
settings defined in your
Personal Profile
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2. Change the maximum transmission and reception rates by clicking on the arrows 
or typing a new rate in the text boxes (see Figure 5-7). Note that you cannot 
change the minimum rates while you are connected. To change minimum rates, 
you must hang up from the conference and change the rates using the Contact 
Card Editor. For more information, see “To set transmission and reception rates 
using the Contact Card Editor:” on page 5-18.

3. When you have completed your changes, click OK.

To set transmission and reception rates in a conference:

(Mac OS)

1. Click the Customize button on the Conference Room toolbar. Point to 
Hardware, then click. The Customize dialog box appears (with the Hardware tab 
displayed), as shown in Figure 5-7.

Figure 5-8. (Mac OS) You can change transmission and reception rates while in a conference

2. Change the maximum transmission and reception rates by clicking on the arrows 
or typing a new rate in the text boxes (see Figure 5-8). Note that you cannot 
change the minimum rates while you are connected. To change minimum rates, 
you must hang up from the conference and change the rates using the Contact 
Card Editor. For more information, see “To set transmission and reception rates 
using the Contact Card Editor:” on page 5-18.

3. When you have completed your changes, click OK.

Select this to 
modify settings

Enter maximum
transmission rate
(Kbps)

Enter maximum
reception rate
(Kbps)

Select this to use the
settings defined in your
Personal Profile
5-20     CU-SeeMe User Guide



Setting Transm
ission and R

eception R
ates
Setting Rates While Manually Dialing
You can set both new and minimum transmission and reception rates for a specific 

connection, for example, when you are manually dialing someone.

To set transmission and reception rates while manually dialing:

1. Click the Manual Dial button on the Phone Book toolbar. The Manual Dial dialog 
box appears. 

2. Select the Network tab as shown in Figure 5-9.

Figure 5-9. You can modify transmission and reception rates for a call

3. If the Use profile settings option is selected, your call will use the settings defined 
in your Personal Profile. (See “Setting Rates for a Personal Profile” on page 5-22.) 
If you want to use different settings for this call, select the Use custom settings 
option. Enter the maximum transmission and reception rates you want to use for 
the call by clicking the arrows or typing a new rate in the text boxes (see Figure 
5-9). 

4. To set different minimum transmission and reception rates for the call, select the 
Enforce minimum rates settings check box, then enter the new minimum rates. 

5. When you have completed your changes, click Manual Dial or select another tab 
to make additional changes.

Enter maximum recep-

Select this to 
modify settings

Select this to use the
settings defined in your
Personal Profile

Enter maximum 
 transmission rate to use

calling (Kbps)
when calling (Kbps) tion rate to use when 

Enter a minimum
reception rate

Enter a minimum 
transmission rate
(Kbps)

(Kbps)

Select this to use the
minimum reception
and transmission rates
you define
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Setting Rates for a Personal Profile
You can set maximum transmission and reception rates for each Personal Profile that 

is stored in your Phone Book. For example, if you have a portable computer that uses 

a LAN from your office and a modem from your home, you would want to have two 

different sets of maximum transmission and reception rates, one for each location. In 

this instance, you would define one Personal Profile to use from your office and 

another to use from your home. Each profile would have rates defined for the specific 

network type.

To set transmission and reception rates for a Personal Profile:

1. Click the Call Options button on the Phone Book toolbar. Point to Profiles, then 
click.

2. The CU-SeeMe Call Options dialog box appears (with the Profiles tab displayed).

3. Select a Profile from the list. Then click Edit.

4. The Personal Profile Editor appears. Select the Hardware tab, as shown in 
Figure 5-10.

Figure 5-10. Select a network configuration in the Personal Profile Editor

Click here to display
a drop-down list from 
which you can select your
type of network

Click here to 
display the
Customize Network
dialog box
5-22     CU-SeeMe User Guide



Setting Transm
ission and R

eception R
ates
5. In the Network Configuration section, use the drop-down list to select the network 
type that most closely matches yours. Then click Customize.

6. The Customize Network dialog box appears, as shown in Figure 5-11.

Figure 5-11. You can modify maximum transmission and reception rates

7. Change the maximum transmission and reception rates by clicking on the arrows 
or typing a new rate in the text boxes (see Figure 5-11). Note that you cannot 
change the minimum rates for a Personal Profile. To change minimum rates, you 
must change the rates using the Contact Card Editor. For more information, see 
“To set transmission and reception rates using the Contact Card Editor:” on page 
5-18.

8. Click OK. 

9. When you have completed all your edits to the Personal Profile, click OK.

10. Then click OK again to close the CU-SeeMe Call Options dialog box.

Enter maximum
transmission rate
(Kbps)

Enter maximum
reception rate
(Kbps)
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Registering With an Online Directory Service
A directory service is an online listing that allows users of CU-SeeMe to find each 

other, see if they are online, and connect directly to them. CU-SeeMe uses an Internet 

Locator Server (ILS) to keep track of you and your contacts.

Each computer on the Internet has an Internet Protocol (IP) address that is a unique 

identifier. Many Internet Service Providers and online services assign IP address 

dynamically; that is, you get a new IP address each time you connect to the Internet. 

This is like changing your telephone number each time you place a call, and it has 

made it difficult in the past for online users to find and connect to each other. The ILS 

server solves this problem by automatically registering your current IP address as soon 

as you connect to the Internet, making it easy for other people to locate you.

When you set up CU-SeeMe on your computer, you were given the opportunity to 

register with an ILS server (see “Using the Setup Assistant” on page 2-2). If you chose 

this option, you are now registered and other CU-SeeMe users will be able to locate 

you online. If you did not choose this registration option during set up, you can still 

register at any time by setting your directory preferences in the Contact List (see 

“Changing Your Contact List Preferences” on page 6-16).
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Configuring a Web Page to Launch CU-SeeMe
CU-SeeMe can be launched directly from a Web page displayed in a Web browser. By 

setting up CU-SeeMe to launch from a Web page, you can provide access to additional 

information that wouldn’t be feasible if you were to use CU-SeeMe by itself. For 

example, you may want to set up a camera to display a classroom. Although this could 

be done using CU-SeeMe by itself, you could provide additional materials to viewers, 

such as text and graphics, by placing this material on a Web page.

You can also create a Web page with a link to launch CU-SeeMe as a convenience to 

readers of your Web page. For example, if you host a conference, you can use a Web 

page to publicize the conference and allow users to join the conference directly from 

the Web page.

To launch CU-SeeMe from a Web page, you must configure your browser to 

automatically launch CU-SeeMe when prompted by a .cu file.

In addition, the Web administrator must set up the Web page and Web server as 

follows:

◆ Create a Web page that links to a .cu file (a file type used to launch CU-SeeMe 
and connect to a conference).

◆ Ensure that the Web server recognizes CU-SeeMe’s MIME type. Use your Web 
server’s facilities to configure the mapping between the CU-SeeMe MIME type 
and the .cu file extension:

MIME type: application/x-cuseeme

Extension: .cu

Creating the File that Launches a Conference
If you want other CU-SeeMe users to be able to launch CU-SeeMe and join a 

conference directly from your Web page, you need to create a Web page with a link to 

a .cu file. This .cu file defines the IP address and Conference ID of the conference 

server to which you want users to connect. Place this file, with the other html files, on 

the Web server.

Each entry in your Phone Book can become a .cu file. You can create a .cu file from a 

Phone Book entry by exporting the Contact Card associated with that entry.
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To export a Phone Book entry as a .cu file:

1. Select an entry in the List of Contact Cards.

2. On the File menu, point to Export. Then point to Selected Contact Card and 
click.

3. A dialog box appears where you can define the file name and location for the new 
.cu file. Save the file as a .cu file type and click OK.

You can also drag an entry from the List of Contact Cards and drop it on your desktop 

(or any folder). This entry automatically becomes a standalone .cu file. For example, 

if you drag-and-drop the entry for White Pine Cafe from your Phone Book to your 

desktop, it creates a file called White Pine Cafe.cu. This .cu file retains all the 

connection properties of the original Phone Book entry, such as IP address, network 

connections, and so on.

See “Adding Entries in the Phone Book” on page 3-20 for information on creating new 

Phone Book entries.

(Windows) If you are a Windows user, you can create a blank .cu file, and then edit 

its properties as follows:

1. From the Windows desktop, click Start, point to Programs, point to Accessories, 
then click Notepad. A blank Notepad file appears.

2. Choose File, then Save As. Enter a file name of your choice, followed by a .cu 
extension, for example, whitepine.cu. Click Save then quit Notepad. 

3. Right-click on the file’s icon to display the shortcut menu, then choose 
Properties. The Properties dialog box appears. (This dialog box works similar to 
the Contact Card Properties dialog box. See “Editing a Contact Card” on page 
3-23.) 

4. Enter the appropriate information in each of the tabs, for example:

• The IP address - the address of the conference server or CU-SeeMe host to 
which you would like to connect using CU-SeeMe

• Conference ID - the conference ID used by the conference server
If you want users to connect directly to a specific conference on your server and 
bypass the dialog box that lists all available Conference Rooms, you need to 
specify the conference ID number preceded by 0 (zero). For example, if you 
want users to connect to Conference 2, specify the Conference ID number as 
02.

5. Click OK when you are done.
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Configuring Your Browser to Launch CU-SeeMe
You can configure the Web browser installed on your computer to launch CU-SeeMe 

when it encounters a .cu file linked from a Web page. There are many versions of Web 

browsers available for use and it is beyond the scope of this User Guide to explain how 

to configure every Web browser. Consult the documentation or online Help for your 

Web browser to learn how to configure your browser.

As a general guideline, follow these steps:

1. Locate the dialog box to add new file types in your browser, typically in a 
preferences dialog box. For example:

• Netscape Navigator™ 3.0 - Choose General Preferences from the Options 
menu, then select Helpers. Now click on Create New Type.

• Netscape Navigator 4.0 - Choose Preferences from the Edit menu, then 
Navigator (under Category), then select Applications.

• Internet Explorer 3.0 - Choose Options from the View menu, then the 
Programs tab, then File Types, and finally New Type.

2. Specify the mime type (if applicable): application

3. Specify the mime subtype (if applicable): x-cu-seeme

4. Specify the file extension or suffix: .cu

5. Specify CU-SeeMe as the application. You can use the Browse or Choose option 
to search for the CU-SeeMe program.

(Windows) Make sure CU-SeeMe is in your path, or specify the full pathname of 

the cuseeme executable. 

6. Set the action to launch the application.

Additional information is available in the Frequently Asked Questions (FAQ) section 

of White Pine’s Technical Support Web pages at http://support.wpine.com/cuseeme.
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Chapter 6

Using the Contact List

The Contact List offers a handy way to keep track of the people that you 

videoconference with. In addition to organizing your information, the Contact List 

automatically shows who on your list is currently online and able to receive a call.

This chapter describes how the Contact List operates, and how to use it to organize 

your contact information. It also tells you how to update your own information so 

that other users can quickly find you.
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Starting the Contact List
The Contact List is a separate application from CU-SeeMe. You can run it even if 

CU-SeeMe is not currently running.

To start the Contact list:

(Windows)

◆ Select the CU-SeeMe folder from the Windows Start button, then choose Contact 
List

(Mac OS)

◆ Double-click the Contact List icon in the CU-SeeMe folder
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Components of the Contact List
The components of the Contact List window are shown in Figure 6-1.

Figure 6-1 The Contact List window

The components are explained in the following sections, as shown in Table 6-1.

Table 6-1 Where to find information on Contact List components

To find out information about... Go to...

Contact List Menus page 6-4

Contact List Toolbar page 6-9

Contact List Groups page 6-11

Contacts page 6-11

Status Bar page 6-10

Menus

Toolbar

Contacts

Status bar

Groups
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Contact List Menus
You can access CU-SeeMe commands from the Contact List menus. You activate a 

menu by clicking on it. When you do, the menu’s commands are displayed. If a 

command is not available to you, it appears dimmed. Commands in the menu that are 

followed by ellipsis (...) need more information from you before they execute. These 

commands display dialog boxes that ask you for more information. Commands in the 

menu that are followed by a triangle indicate that a submenu is available. Pause your 

mouse pointer over that command and a submenu will appear. 

Explanations and descriptions of the Contact List commands for both Windows and 

Mac OS start on page 6-4. 

The CU-SeeMe Menu for Mac OS

There are some differences in the appearance of CU-SeeMe, depending on whether it 

is running on the Windows or Mac OS operating system. One notable difference is 

that, in Windows, the menu is located at the top of the Contact List window. In the Mac 

OS, the menu bar is not attached to the Contact List window. Instead, it is always found 

at the top of your screen.

The Help menu for Mac OS 8 appears on the menu bar. In earlier Mac OS versions, 

the Help menu appears as a question mark  at the top right corner of the screen.

Commands specific to Windows or Mac OS in the following tables are noted with 

parentheses ( ). Only active Contact List commands are included, so Mac OS 

commands that are unavailable from the Contact List are not explained in this chapter. 
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File Menu
The commands under the File menu are described in Table 6-2.

Table 6-2 The commands under the File menu in the Contact List

File Command Description

Send Mail... Sends e-mail to the address on the selected 
contact. 
(Windows - Your e-mail program must be 
configured to use MAPI. See your e-mail 
vendor’s documentation to learn if it is 
MAPI-compliant.)
(Mac OS - CU-SeeMe will use your default 
e-mail program. To change your e-mail 
program, click the Call Options button, and 
select Phone Book. Click the Launch 
Internet Config button. Click on Helpers, 
select mailto, click the Change button, then 
click Choose Helper to choose the e-mail 
program you want to use. Click OK when 
done.)

Open Directory Displays the ILS Directory window, which 
lists people currently online and available 
for videoconferencing.

Exit (Windows)
Quit (Mac OS)

Exits the CU-SeeMe program.
Chapter 6. Using the Contact List          6-5



C
on

ta
ct

 L
is

t M
en

us
Edit Menu
The commands under the Edit menu are described in Table 6-3.

Table 6-3 The commands under the Edit menu in the Contact List

Edit Command Description

Undo Reverses the last text edit, such as 
renaming an entry in the list of Contacts.

Cut Removes the selected Contact from your 
Contact List and puts it on the Clipboard.

Copy Copies the selected Contact to the 
Clipboard.

Paste Pastes the current content of the Clipboard.

Delete Deletes the selected Contact.

Select All Selects all the Contacts in the current 
Contact Group.

Preferences... Displays the Preferences dialog box where 
you can change your ILS settings. (See 
Chapter 7.)
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Contact Menu
The commands under the Contact menu are described in Table 6-4.

Table 6-4 The commands under the Contact menu in the Contact List

Help Menu
The commands under the Help menu are described in Table 6-5.

Table 6-5 The commands under the Help menu in the Contact List

Contact Command Description

Speed Dial Place a CU-SeeMe call to the selected 
contact.

Refresh Updates the online status of all of your 
contacts.

New Group Create a new group to organize contacts 
under.

New Contact... Displays a dialog box in which to type the 
name and e-mail address of a new contact.

Edit Contact Displays a dialog box that allows you to 
change the name or e-mail address of the 
selected contact.

Properties Displays information about the selected 
contact.

Edit Command Description

CU-SeeMe Help Topics Opens the Contents window of the help 
system.

Search For Help On (Windows) Opens the Index window of the help system.

CU-SeeMe World Launches a web browser to open the 
CU-SeeMe World web site, where you can 
find information about fun things to do and 
see with CU-SeeMe.

Technical Support Launches a web browser to open the White 
Pine Software Technical Support web page.
Chapter 6. Using the Contact List          6-7



C
on

ta
ct

 L
is

t M
en

us
Registration Launches a web browser to open the White 
Pine Software Product Registration web 
page, where you can register your copy of 
CU-SeeMe online.

About Contact List... 
(Windows)

Displays information about your version of 
Contact List.
In the Mac OS, this command is found 
under the Apple  menu.

Edit Command Description
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Contact List Toolbar
The Contact List toolbar has buttons that provide shortcuts to many commands. As you 

move your mouse pointer over each button, the selected button becomes highlighted. 

You can then click the button to activate it.

When you pause your mouse pointer on a button, a tool tip appears. No clicking is 

necessary. The tool tip gives you information about the function of the button.

The Contact List toolbar buttons are explained in Table 6-6.

Table 6-6 The Contact List toolbar buttons

Toolbar Button Description

Creates a new group.

Creates a new contact.

Places a CU-SeeMe call to the selected 
contact.

Displays the ILS Directory window.
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The Status Bar, located at the bottom of the Contact List window, provides tips and 

information about your current task. For example, when you select a contact from the 

list, the Status Bar indicates whether or not that person is currently online and able to 

receive calls.

In Figure 6-2, the status bar indicates that the selected contact is ready to be Speed 

Dialed.

Figure 6-2 The Status Bar provides additional information
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Contacts and Groups
The Contact List is like a flexible phonebook that keeps track of the people you 

videoconference with. Unlike a paper-based phone book, however, the Contact List 

tells you which of the members of your list are online and available to accept your call.

You can choose to arrange the people on your list into categories, called groups. 

Entries can appear in more than one group. Figure 6-3 shows five contacts arranged 

into three groups.

Figure 6-3 Several contacts arranged into groups

Each contact is represented by an icon. The meaning of each icon is explained in Table 

6-7.

Table 6-7 Contact Icons

Icon Explanation

The person is online and ready to receive a call.

The person is not currently online.

The ILS server associated with this person is 
not available
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Creating New Contacts
You can create new contacts in a variety of ways. Each of the following will display 

the New Contact dialog box, where you can enter the name and e-mail address of your 

new contact. The New Contact dialog box is shown in Figure 6-4.

◆ Click the New Contact button on the Contact List toolbar.

◆ Select New Contact from the Contact menu

◆ Press Control-N (Windows) or Command-N (MacOS)

◆ (Windows) Right-click on an existing group or contact and select New Contact 
from the popup menu that appears. If there are no groups or contacts defined yet, 
right-click anywhere in the contact list area

◆ (Windows) Click and hold a name that appears in the ILS Directory window (see 
Chapter 7). Drag the name from the Directory to the Contact List.

Figure 6-4 The New Contact dialog box

In the Nickname field, type the name of the new contact. This is the name that will 

appear in your contact list. 

In the ILS/E-mail field, type the e-mail address of your contact. The combination of 

the ILS server and e-mail address is what CU-SeeMe uses to determine whether or not 

someone is online. 

If you know the name or IP address of the ILS server for this contact, you should 

include it in the E-mail field in the form: ils-address/e-mail-address. For example, if 

the e-mail address of your contact is pinetree@wpine.com and you know that 

the contact is registered at the ILS server ils.cuseeme.com, you may type 

ils.cuseeme.com/pinetree@wpine.com into the E-mail field. CU-SeeMe 

supplies the name of your default ILS server in the ILS/E-mail field.
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Your new contact will be placed under the currently selected group.

Creating New Groups
To create a new group, use any of the following methods to place a new group icon in 

the contact list area, as shown in Figure 6-5. Then type the name of your new group in 

the box next to the group icon.

◆ Click the Group button on the Contact List toolbar.

◆ Select New Group from the Contact menu

◆ (Windows) Right-click on an existing group or contact and select New Group 
from the popup menu that appears. If there are no groups or contacts defined yet, 
right-click anywhere in the contact list area.

Figure 6-5 Adding a new group

Editing Contacts and Groups
To change the name of a contact or group, or the e-mail address of a contact, highlight 

the contact or name and select Edit Contact from the Contact menu. Windows users 

may right-click on the group or name and select Edit from the popup menu that 

appears. 

Note: Deleting a group will also delete all of the contacts in it. If there are contacts 
in a group that you want to save, move them first to another group.

Type a new group
name in the box
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To delete a contact or group, highlight it and press the Delete key or select Delete from 

the Edit menu. You will be prompted to confirm the operation.

Arranging Contacts Into Groups
You can organize your contacts into categories, or Contact Groups. For example, you 

might want a group containing all of your business contacts, and another for your 

social contacts. If you share your computer with other people, everyone could have 

their own Contact Group.

To move a contact to a new group, simply drag and drop the contact icon onto the new 

group. You may also cut and paste contacts by selecting those operations from the Edit 

menu.

Contacts can appear in more than one group, but they can’t have the same name. For 

example, Figure 6-6 shows a Contact List with three groups; Willy appears once in the 

Associates group, and again as Willy - 0 in the Family group.

Figure 6-6 Names in the Contact List must be unique
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Making Calls From the Contact List
You can place an immediate call to a contact in your list that is online. Each of the 

following methods will place a call:

• Double-click the contact

• Highlight the contact and click the Speed Dial button on the toolbar

• Highlight the contact and select Speed Dial from the Contact menu

• Highlight the contact and press the Enter key

• Right-click a contact and select Speed Dial from the pop-up menu (Windows)
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Changing Your Contact List Preferences
Use the Contact List Preferences dialog to customize the features of the Contact List, 

and to set your personal information. To open the Preferences dialog:

• Select Preferences... from the Edit menu, or

• Right-click the Contact List tray icon and select Preferences from the pop-up 
menu (Windows).

The Preferences dialog has two pages, selected by tabs:

• General

• My Information

Changing General Preferences
The General Preferences dialog is shown in Figure 6-7. Each of its options is described 

in Table 6-8.

Figure 6-7 The Contact List Preferences Dialog
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Changing Personal Preferences
The My Information tab is shown in Figure 6-8. Each of its options is described in 

Table 6-9.

Table 6-8 Contact List: General Preferences

Setting Description

Log on to the directory 
server

If selected, the Contact List will automatically tell 
your ILS server that you are online each time you 
start the computer.

Do not list my name in 
the directory

If selected, your name will not appear on the ILS 
Directory server listing. Other users’ Contact Lists 
will still correctly show whether or not you are 
online, but you will need to tell those users what ILS 
server and e-mail address you have selected.

Automatically refresh the 
Contact list

If selected, the Contact List will automatically check 
the status of your contacts at ten-minute intervals. If 
this option is disabled, you must manually refresh 
each contact when you want to see if the person is 
online.

Launch the Contact list 
at startup

If selected, the Contact List will run in the 
background each time you start your computer.

Advertise on: Select an ILS server on which to advertise from the 
pull-down list.

Advertise on another 
ILS:

If you want your online status to be posted to an ILS 
server that does not appear in the pull-down list, 
you may type its name in this box.

Start White Pine 
CU-SeeMe Listener

If selected, automatically runs a program in the 
background that listens for incoming CU-SeeMe 
calls. See “Using the Listener” on page 3-30.

Start Microsoft 
NetMeeting Listener 
(Windows)

If selected, automatically runs a program in the 
background that listens for incoming NetMeeting 
calls. See “Using the Listener” on page 3-30.
Chapter 6. Using the Contact List          6-17



C
ha

ng
in

g 
Yo

ur
 C

on
ta

ct
 L

is
t P

re
fe

re
nc

es
Figure 6-8 The Contact List My Information Tab

NOTE: The Contact List publishes information about you to an ILS server. This 

information is then available for anyone on the Internet to read. If you don’t want 

certain information to be made public, you can leave the associated field in the My 

Information tab blank.

Table 6-9 Contact List: My Information

Setting Description

Name Enter the name that you want to appear on your ILS 
server listing. You may fill in either the First Name or 
Last Name boxes, or both. You may choose any 
name that you like, including the nickname that you 
use on CU-SeeMe.

E-mail address The e-mail address is the only required field on the 
My Information tab. The ILS server uses your 
e-mail address to keep track of your listing. 

Address Fill in as much or as little of your address as you 
want to appear on the ILS server. Remember that 
any information you place in these fields, such as 
your city or state, will be available for anyone on the 
Internet to read.
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Comments Use the Comments field to personalize your listing. 
Any text that you place in this box will appear next 
to your listing on the ILS server.

I would like to categorize 
my information as:

Each ILS server groups its contact information into 
categories. The ILS server listing can be sorted by 
these categories. Click on the category that you 
want your listing to appear under.

Table 6-9 Contact List: My Information

Setting Description
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Changing Your Availability (Windows)
Whenever you start the Contact List, it informs an ILS server that you are online and 

available to receive calls. You can set your availability at any time to either “I am 

available,” or “Do not disturb me.” 

To change your availability, right-click on the small Contact List icon in the Windows 

tool tray, then make a selection from the pop-up menu, as shown in Figure 6-9.

Figure 6-9 Selecting Your Availability

When your availability is set to “Do not disturb me,” your personal information will 

not be sent to an ILS server, and you will no longer appear on the server’s list of 

contacts.

When your availability is set to “I am available,” your information will be sent to an 

ILS server and you will appear in the server’s list of contacts.
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Checking Contact List Status (Windows)
When the Contact List is running, a small icon appears in the Windows tool tray, which 

is typically located on the lower-right portion of your screen. Table 6-10 describes the 

three Contact List icons that may appear and what they indicate. You may double-click 

the icon on the tool tray to display the Contact List window. You may also right-click 

the icon to display the pop-up menu shown in Figure 6-9.

Table 6-10 Contact List Icons

Contact List Icon Status

The Contact List is 
communicating with an ILS 
server, and your information is 
being published.

The Contact List is 
communicating with an ILS 
server, however your information 
is not being published.

The Contact List is unable to 
communicate with an ILS server.
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Chapter 7

Using the Directory

The White Pine Directory is an active listing of who is online and available to 

receive a videoconferencing call. To be displayed in the Directory you must first 

register with an ILS server (see “Using the Setup Assistant” on page 2-2). Once you 

are registered, CU-SeeMe automatically publishes your contact information to the 

ILS server whenever you connect to the Internet.

You can use the Directory to place calls directly, or you can select contacts that are 

listed in the Directory and save them in your Contact List (see Chapter 6).

This chapter describes the parts of the Directory, and explains how to use the 

information that the Directory displays.
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How Does ILS Work?
Many Internet users are assigned a random network, or IP, address each time they 

connect to the Internet. This can be a problem for CU-SeeMe users who want to 

directly dial a particular person, since CU-SeeMe uses the IP address to make its 

connection.

The Internet Locator Server (ILS) solves this problem by automatically registering the 

IP address of each user every time they connect to the Internet. Instead of connecting 

to a specific IP address, CU-SeeMe users can use the Directory or the Contact List to 

place a call to a name. CU-SeeMe asks the appropriate ILS server to look up the 

current IP address of the person who is being called, and the connection is established.

You can choose which ILS server you would like to be listed on. For information about 

how to do this, see “Changing Your Contact List Preferences” on page 6-16.

The ILS server keeps track of registered users by storing their e-mail address along 

with the current IP address. When you tell other users your ILS address, or when you 

receive ILS information from a friend, it will be in the form: ils-server/e-mail-address. 

For example, if you are using the ILS server ils.cuseeme.com, and your address is 

pinetree@wpine.com, you would tell other users that your ILS information is 

ils.cuseeme.com/pinetree@wpine.com.

How the Directory and Contact List Interact
The Directory window provides a list of all the users who are currently online and 

registered with a single ILS server. You can easily choose any ILS server to view. 

Contacts that appear on the ILS list can then be copied to your Contact List.

The Contact List keeps track of each individual listed in it by periodically asking the 

appropriate ILS server whether or not the person is currently online. You can tell 

instantly by looking at your Contact List who is online and who is not.

You can place contacts in your Contact List in two ways:

• Drag and drop a contact from the Directory window to the Contact List

• Create a new contact in the Contact List and type in the ILS server and e-mail 
address of the contact
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Starting the Directory
The Directory may be started from the toolbar of either the Contact List or the 

Conference Room by clicking on the Directory button. Figure 7-1 shows the Contact 

List toolbar with the Directory button highlighted.

Figure 7-1 The Directory button on the toolbar
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Components of the Directory
The components of the Directory are shown in Figure 7-2.

Figure 7-2 The Directory window

The Directory components are explained in the following sections, as shown in Table 

7-1.

Table 7-1 Where to find information on Directory components

To find out information about... Go to...

Directory Menus page 7-5

Directory Toolbar page 7-9

ILS Categories page 7-10

ILS Servers page 7-11

Directory Listings page 7-12

Directory Status Bar page 7-13

Menus

Toolbar

ILS Category

Listing Area

ILS Server

Status bar
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Directory Menus
You can access CU-SeeMe commands from the Directory menus. You activate a menu 

by clicking on it. When you do, the menu’s commands are displayed. If a command is 

not available to you, it appears dimmed. Commands in the menu that are followed by 

ellipsis (...) need more information from you before they execute. These commands 

display dialog boxes that ask you for more information. Commands in the menu that 

are followed by a triangle indicate that a submenu is available. Pause your mouse 

pointer over that command and a submenu will appear. 

Explanations and descriptions of the Directory commands for both Windows and Mac 

OS appear in the following sections. 

The CU-SeeMe Menu for Mac OS

There are some differences in the appearance of CU-SeeMe, depending on whether it 

is running on the Windows or Mac OS operating system. One notable difference is 

that, in Windows, the menu is located at the top of the Directory window. In the Mac 

OS, the menu bar is not attached to the Directory window. Instead, it is always found 

at the top of your screen.

The Help menu for Mac OS 8 appears on the menu bar, as shown above. In earlier Mac 

OS versions, the Help menu appears as a question mark  at the top right corner of 

the screen.

Commands specific to Windows or Mac OS in the following tables are noted with 

parentheses ( ). Only active Directory commands are included, so Mac OS commands 

that are unavailable from the Directory are not explained in this chapter. 
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File Menu
The commands under the File menu are described in Table 7-2.

Table 7-2 The commands under the File menu in the Directory

File Command Description

Send Mail (Windows) Sends an e-mail message to the selected contact. 
Your e-mail program must be configured to use 
MAPI. See your e-mail vendor’s documentation to 
learn if it is MAPI compliant.

Exit (Windows)
Quit (Mac OS)

Exits the Directory.
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Edit Menu
The commands under the File menu are described in Table 7-3. Only the commands 

listed below are active.

Figure 7-3 The Properties box in the Directory

Table 7-3 The commands under the Edit menu in the Directory

Edit Command Description

Copy Copies the selected Contact Card to the Clipboard.

Properties Displays information about the selected contact, as 
shown in Figure 7-3. Depending on the information 
supplied by the contact, not all information may be 
displayed (see “Changing Your Contact List 
Preferences” on page 6-16).
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Directory Menu
The commands under the Directory menu are described in Table 7-4.

Help Menu
The commands under the Help menu are described in Table 7-5.

Table 7-4 The commands under the Directory menu in the Directory

Directory Command Description

Speed Dial Places an immediate call to the selected contact

Refresh Reloads contact information from the ILS server.

Stop Stops loading information from the ILS server.

Table 7-5 The commands under the Help menu in the Directory

Help Command Description

CU-SeeMe Help Topics Opens the CU-SeeMe Help file and displays the 
contents of the Help file.

Search for Help On 
(Windows)

Opens the CU-SeeMe Help file and displays the 
Find page.

CU-SeeMe World Launches a web browser to open the CU-SeeMe 
World Web site, where you can find information 
about fun things to do and see with CU-SeeMe, 
and be a part of the CU-SeeMe community.

Technical Support Opens a Web browser and displays the White Pine 
Software Technical Support Web page.

Registration Opens a Web browser and displays the White Pine 
Software Product Registration Web page, allowing 
you to register your copy of CU-SeeMe online.

About Directory... 
(Windows)

Displays information about your version of 
Directory.
In the Mac OS, this command is found under the 
Apple  menu.
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Directory Toolbar
The Directory toolbar has buttons that provide shortcuts to many commands. As you 

move your mouse pointer over each button, the selected button becomes highlighted. 

You can then click the button to select it.

When you pause your mouse pointer on each button, a tool tip appears. No clicking is 

necessary. The tool tip gives you information about the function of each button.

The Directory toolbar buttons are explained in Table 7-6.

Table 7-6 The Directory toolbar buttons

Toolbar Button Description

Stops refreshing the contact list from the ILS 
server.

Reloads contact information from the ILS server.

Places an immediate call to the selected contact.

Launches a Web browser to open the CU-SeeMe 
World Web site, where you can find information 
about fun things to do and see with CU-SeeMe, 
and be a part of the CU-SeeMe community.

Sends an e-mail message to the selected contact. 
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ILS Categories
Each ILS server maintains information about the contacts that are registered on it, 

including the category that each contact wants to be listed under. ILS directory users 

can filter the contacts that are listed by selecting a specific category. You may also see 

all of the contacts on the server by choosing the category All.

Figure 7-4 shows the ILS Category pull-down menu. When you select a category from 

the menu, the list of contact will immediately change to show only those contacts who 

are registered under the category.

Figure 7-4 The ILS Category pull-down menu

To change the category that your own contact information is registered under, choose 

Preferences... from the Contact List Edit menu, then select the tab labeled My 

Information. You can read more about setting your Contact List preferences on page 

6-16.
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ILS Servers
There are many ILS servers running on the Internet. You may display the directory list 

of any ILS server by typing the server name into the ILS Server box. A pull-down 

menu, shown in Figure 7-5, stores the names that you have typed previously.

If you want to keep track of contacts from several different ILS servers, copy each 

contact to your Contact List (see “Contacts and Groups” on page 6-11). The Contact 

List is able to monitor all of the ILS servers used by the contacts in your list.

Figure 7-5 Choose an ILS server from the pull-down menu
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Directory Listings
This portion of the Directory lists all of the contacts currently online for the selected 

ILS server. The list is filtered by the ILS category that you have selected (see “ILS 

Categories” on page 7-10). In Figure 7-6, only contacts who have registered in the 

Business category are shown.

You may sort the list by Name, E-mail address, or Comment by clicking on the column 

name at the top of the listing.

To place a call, highlight a contact and click the Speed Dial button on the Directory 

toolbar. You may also double-click the contact name.

Figure 7-6 This Directory listing shows only the Business category
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Directory Status Bar
The Status Bar, located at the bottom of the Directory window, provides tips and 

information about your current status. In Figure 7-7, the Status Bar is indicating that 

the selected contact is available for speed dialing.

Figure 7-7 The Status Bar provides tips and information
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Appendix A
Technical Support

This Appendix contains information on how to contact White Pine for technical 

support and sales information.
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Getting Technical Support
White Pine Software provides 90 days of free telephone support to all registered users 

after purchasing and registering the product. Only purchased copies of the product can 

be registered, meaning that you can not register any of the freeware versions of 

CU-SeeMe available through Cornell University. 

Registering CU-SeeMe
You must register with White Pine in order to receive technical support. You can 

register in any of the following ways:

◆ Complete the registration card included with CU-SeeMe and mail it to White Pine.

◆ From the Help menu in CU-SeeMe, click Registration. This opens a Web browser 
and displays the White Pine Software Product Registration Web page, allowing 
you to register your copy of CU-SeeMe online. 

◆ Using any Web browser, go to the CU-SeeMe Web page at 
http://www.cuseeme.com and select Register CU-SeeMe. Fill out the online form 
to register your copy of CU-SeeMe.

Support on the World Wide Web
The White Pine Web pages offer a variety of information about the company, products, 

and demo versions of released software, in addition to technical support.

The Technical Support pages offer online registration, technical support through an 

interactive form, and a list of Frequently Asked Questions about using CU-SeeMe.

You can reach the White Pine Software technical support Web page at 

http://support.wpine.com/cuseeme.
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Before You Contact Technical Support
White Pine Software provides technical support to registered users. Return your user 

registration card promptly or register CU-SeeMe using online registration (see 

“Registering CU-SeeMe” on page A-2). Product registration guarantees you new 

product notification and product upgrades.

To get your problems solved as quickly as possible, the technical support staff requires 

as much pertinent information as possible. If you can supply us with this information 

at the time of your call, we can understand and resolve your problem much faster. You 

should have this information ready and be at your computer when you call for technical 

support and be ready to reproduce the problem while talking to a technical support staff 

member.

Please fill out the following information before calling:

Serial #:

Product:

Version:

Date Purchased:

Original Purchaser:
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Your Computer Configuration
Make and Model: 

Microsoft Windows or Mac OS Version: 

Disk Space: 

Memory (RAM): 

Video Card Manufacturer and Model: 

Video Capture Card Manufacturer and Model: 

Sound Card Manufacturer and Model: 

Camera Manufacturer and Model: 
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Communications Configuration
Internet Connection:

Ethernet:        ISDN:         Modem:

Modem Manufacturer and Model:

Model of your Ethernet board:

Network drivers and other communication software installed on your system:

◆ TCP/IP Driver:

◆ Dial-up PPP (if using a modem):

◆ Internet Service Provider (ISP): 
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Contacting White Pine Software

Technical Support
Online form: http://www.cuseeme.com/cu-support.html

Phone: 603-594-2804 8:00 am - 8:00 pm EST

Corporate Headquarters
White Pine Software, Inc.

542 Amherst Street

Nashua, NH 03063 USA

Phone: 603-886-9050

Fax: 603-886-9051

E-mail: info@wpine.com

WWW: http://www.wpine.com 

European Headquarters
White Pine Software, SA

9551, route de Saint Laurent du Var

06610 La Gaude France

Phone: +33.4.93.59.43.43

Fax: +33.4.93.24.76.06

E-mail: euro-info@whitepine.fr 
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Sales Hot Line
For more information about all White Pine Software products, please contact the White 

Pine Software sales department. Demos and product information are also available on 

the World Wide Web. 

U.S. E-Mail:  info@wpine.com

U.S. Phone:  1-800-241-PINE (7463)

Europe E-Mail:  euro-info@whitepine.fr

Europe Phone:  +33.4.93.59.43.43

WWW: http://www.cuseeme.com
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Glossary

Bandwidth

The capacity to send information on a network. It is usually measured in 

bits per second (bps) or kilobits per second (Kbps).

Browser

A software program that allows a user to access resources on the Internet. 

Chat Macro

Shortcut buttons that allow you to automate typing of words, phrases, or 

symbols that you use often.

Chat Window

A feature of CU-SeeMe that allows users to converse using text 

messages. The Chat window is a component of the CU-SeeMe 

Conference Room window.

Codec

COmpressor/DECompressor; Hardware or software that compresses and 

decompresses audio and video data. CU-SeeMe uses software codecs.

Conference ID

A number between 1 and 32768 that is provided to attendees of a private 

conference session. This ID number is needed for some conferences.

Conference Room

The CU-SeeMe window in which videoconferencing takes place. It is 

like a virtual meeting room where you can see and talk to others.
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Conference Server

Software, such as MeetingPoint Conference Server, that delivers multimedia 

group interaction across IP networks. A conference server is the server 

program in a client/server videoconferencing solution. (CU-SeeMe is the 

client program.)

Contact Card

A convenient tool for storing information about a person or place. It is like a 

business card or a card in a rotary file. Contact Cards are displayed in the 

CU-SeeMe Phone Book Window.

Contact Group

A collection of Contact Cards.

Contact List

A CU-SeeMe window that keeps track of your personal list of 

videoconference users, showing whether each user is currently online.

CU-SeeMe

Videoconferencing software for desktop computers. 

CU-SeeMe Name

Your user name that appears when you conference with others. Your 

CU-SeeMe name and the CU-SeeMe names of other participants appear in 

the Participants List in the Conference Room window.

Cybercast Conference

The transmission of the same data to a selected group of destinations.

Directory

A CU-SeeMe window that displays users who have registered on a particular 

ILS server and who are currently online.

Full-Duplex

Allows both parties to send and receive audio at the same time. This affects 

the receiver only.

Half-Duplex

Allows only one person to talk at a time. This affects the receiver only.
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Internet

A global network that uses the TCP/IP protocol.

Internet Locator Service (ILS) server

A computer on the Internet that keeps track of users who are registered with 

the server. The ILS server stores each user’s IP address when they connect to 

the Internet, so that other videoconference users can see who is online and 

connect to them without needingto know an IP address.

Internet Service Provider

A company that provides a connection to the Internet for a fee.
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IP Address

The unique numeric address for every computer that is connected to the 

Internet. It has four sections separated by a dot, for example, 100.1.1.1. An IP 

address can be dynamic and is often provided by Internet service providers.

IP Name

The unique name for every computer that is connected to the Internet. 

ISDN

Integrated Services Digital Network; A high bandwidth network used to 

move large amounts of data over phone lines.

Kbps 

An abbreviation meaning kilobits per second, used for measuring bandwidth.

Listener

A CU-SeeMe feature that alerts you to an incoming call.

Local Area Network (LAN)

A network made up of two or more computers connected together. They are 

usually within the same building or within a very short distance (a mile or 

less) to each other.

Local Video

The window containing your video image on your computer screen. This 

video image can be sent to other people using CU-SeeMe.

Lurker

A CU-SeeMe conference participant who is not sending a video image.

MeetingPoint Conference Server

MeetingPoint is White Pine’s H.323 standards-based videoconferencing 

server software.

Message of the Day (MOTD)

A dialog box that appears when users connect to a conference. It can provide 

information about the conference, current and upcoming cybercasts, etc.
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Multicast

The ability to send one stream of video data and one stream of audio data over 

a network, and many users can simultaneously connect to and receive these 

streams of data without the use of additional software. 

Parental Control

A security feature that allows you to put restrictions on the CU-SeeMe calls 

that are made from your computer and the calls accepted by your computer.

Participants List

A component of the Conference Room window that lists the people currently 

connected to a conference.

Personal Profile

A Personal Profile identifies you to other people on the network. It includes 

your CU-SeeMe name, contact information, Parental Control options, and 

more.

Phone Book

A CU-SeeMe feature that works like a personal directory where you can list 

anyone you might want to call. You use the Phone Book to initiate a 

CU-SeeMe videoconference call.

Point-to-Point Conference

A direct connection between two CU-SeeMe users.

PPP

Point-to-Point Protocol. A protocol that allows a computer to make a TCP/IP 

connection using a telephone line and a modem.

Profile Contact Card

When you create a Personal Profile, you also create a Profile Contact Card. It 

is like a business card that you can exchange with others electronically.

Protocol

Standards that allow programs on different computers to communicate.

Remote Video 

The window that contains the video sent by another participant in a 
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conference.

Router

A computer system or software package that connects two or more networks. 

Routers look at the destination addresses of the IP packets and forward them 

to the correct address.

Sender

A CU-SeeMe conference participant who is sending a video image.

TCP/IP

Transmission Control Protocol/Internet Protocol. The protocol that defines 

the Internet.

Time-to-Live (TTL)

A value used by routers that is decremented as it is passed from router to 

router.

URL

Uniform Resource Locator. An “address” used to locate information on the 

Internet.

WhitePineBoard

A feature of CU-SeeMe for Windows that allows users to view, create and/or 

share the same document at the same time.

Wide Area Network (WAN)

A large network made of connected LANs.
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Assistants 1-8

CU-SeeMe Setup Assistant 2-2
Multicast Conference Assistant 3-46
New Contact Card Assistant 3-20
Personal Profile Assistant 3-26
Phone Book Import Assistant 3-22

audio
adjusting levels 4-37
codec 4-39

changing settings 5-14, 5-15
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broadcast

see  cybercast conference
browser

configuring to launch CU-SeeMe 5-27

C
Call menu

Phone Book 3-7, 4-6
Call Options button 3-11
calling 3-16
Chat

customizing 4-26
enabling URL highlighting 4-27
enabling URL launching 4-27
filtering text from selected participants 4-30
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private Chat 4-31
resizing Chat window 4-33
toolbar 4-26
using macros 4-29
window 2-18, 4-26

Close All command 2-15
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choosing 5-7
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Delta-Mod 5-7
DigiTalk 5-7
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Intel DVI 5-7

definition 5-2
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disconnect
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E
echo reduction 4-35, 4-37, 5-10
Edit menu

Conference Room 4-5
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Phone Book 3-5

F
FAQ

see Frequently Asked Questions
File menu

Conference Room 4-4
Directory 7-6
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file type
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.cu 3-22, 3-25
.cu  3-25
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freeze video 5-9
Frequently Asked Questions 5-1

G
G.723.1 5-7
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changing settings 3-32
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enabling 3-30
modifying the notification method 3-34
modifying the response 3-35

local video 2-13
lurker

definition 2-14, 4-12
switching to a sender 2-16, 4-21

M
Manual Dial button 3-11, 3-18
menu

Conference Room 4-3
Contact List 6-4
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Phone Book 3-3

Message of the Day 2-11, 3-17
microphone

adjusting volume 4-37
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squelch control 4-37, 5-15, 5-16
using in Hands Free mode 4-36
using in Push To Talk mode 4-36

M-JPEG
see  codec

multicast conference
creating 3-46
creator 3-45
cybercast 3-45
definition 3-44
enabling 3-45
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sorting 4-15

performance 5-1
Personal Profile
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editing 3-28
Editor 3-28, 5-22
Profile Contact Card 3-1, 3-12, 3-25

exchanging 4-41
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adding entries 3-20
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components 3-2
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menu 3-3
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View 3-7
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Quick Start & Tips window 2-10
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setting 5-17
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setting while in a conference 5-19
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S
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system requirements 1-4

T
technical support
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codec 4-39
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changing the layout 4-23
closing 4-20
closing all 2-15
local 2-13
moving 4-24
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cybercast conference 1-11
definition 1-1
group conference 1-10
multicast 3-44
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View menu
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White Pine Software, Inc. End User License Agreement

THIS IS A CONTRACT. BY INSTALLING THIS SOFTWARE YOU ACCEPT ALL THE TERMS AND CONDITIONS OF
THIS AGREEMENT.

1. White Pine grants to you a non-exclusive, non-sublicensable, license to use this Software in binary executable form.

This White Pine Software, Inc. (“White Pine”) End User License Agreement accompanies a White Pine software product
and related explanatory written materials (“Software”). The term “Software” shall also include any upgrades, modified
versions or updates of the Software licensed to you by White Pine. 

YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE PROGRAM OR DOCUMENTATION, OR ANY COPY
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. White Pine reserves the right at any time to alter prices, features, specifications, capabilities, functions, licensing terms,
release dates, general availability or other characteristics of the commercial release of the software.

3. Title, ownership rights, and intellectual property rights in and to the Software shall remain in White Pine and/or its
suppliers. You agree to abide by the copyright law and all other applicable laws of the United States including, but not
limited to, export control laws. You acknowledge that the Software in source code form remains a confidential trade secret
of White Pine and/or its suppliers and therefore you agree not to modify the Software or attempt to decipher, decompile,
disassemble or reverse engineer the Software, except to the extent applicable laws specifically prohibit such restriction.

4. Copyright. The Software is owned by White Pine and its suppliers, and its structure, organization and code are the
valuable trade secrets of White Pine and its suppliers. The Software is also protected by United States Copyright Law and
International Treaty provisions. You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or
otherwise attempt to discover the source code of the Software. You may use trademarks only to identify printed output
produced by the Software, in accordance with accepted trademark practice, including identification of trademark owner’s
name. Such use of any trademark does not give you any rights of ownership in that trademark. Except as stated above,
this Agreement does not grant you any intellectual property rights in the Software.

5. White Pine may terminate this License at any time by delivering notice to you and you may terminate this License at any
time by destroying or erasing your copy of the Software. In the event of termination, the following sections of this License
will survive: 2, 3, 4, 5, and 6. This License is personal to you and you agree not to assign your rights herein. This License
shall be governed by and construed in accordance with the laws of the State of New Hampshire and, as to matters
affecting copyrights, trademarks and patents, by U.S. federal law. This License sets forth the entire agreement between
you and White Pine.

6. WHITE PINE OR ITS SUPPLIERS SHALL NOT BE LIABLE FOR (a) INCIDENTAL, CONSEQUENTIAL, SPECIAL OR
INDIRECT DAMAGES OF ANY SORT, WHETHER ARISING IN TORT, CONTRACT OR OTHERWISE, EVEN IF WHITE
PINE HAS BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR (b) FOR ANY CLAIM BY ANY OTHER
PARTY. THIS LIMITATION OF LIABILITY SHALL NOT APPLY TO LIABILITY FOR DEATH OR PERSONAL INJURY TO
THE EXTENT APPLICABLE LAW PROHIBITS SUCH LIMITATION. FURTHERMORE, SOME STATES DO NOT ALLOW
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION AND
EXCLUSION MAY NOT APPLY TO YOU.

7. ACKNOWLEDGEMENT: YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT,
AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN THE PARTIES AND SUPERSEDES ALL
PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN
THE PARTIES RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT.

Should you have any questions concerning this Agreement, please contact in writing:

White Pine Software, Inc., 542 Amherst Street, Nashua, NH 03063.
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